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Introduction

CNC Innovations- A team of men and women dedicating their careers to the development of easy to use, shop-
hardened software for the machine tool industry.

From our basic NC file editors and single point-to-point data communications software, to expansive and powerful
DNC networking planners, CNC Innovations is sure to have the best and most affordable products to save you time,
money and, ultimately, headaches in today's quick paced, market environment.

To help us in our endeavor to perfect the industry's best shop automation software tools, feel free to call us at
(508) 523-1763. We are always happy to hear from you--our valued customer.

Sincerely,
The Staff of CNC Innovations

Important Information

Focal*Point is a highly versatile DNC communications program with a host of features ranging from simple
point-and-click file transfer to complex network integrated file maintenance. One such feature is Multi-User
Administration with its shared data capabilities. This feature, plus the inherent security of a well-maintained LAN
network, requires a complete understanding of the setup and configuration of this software.

For this reason, it is recommended that both the installer and the LAN Administrator review the LAN Connectivity,
Defaults, and Automatic Library Transfer sections of this manual before activating these features.

About Focal*Point Help

The Focal*Point help program contains a section for all of the program features and functions. Each topic can be
reviewed in whole or by printing the section to a connected printer. Additionally, clicking on any words that are
green and underlined will immediately jump to additional help for the highlighted keyword. If the highlighted word
is underlined by a broken line, the information will be in the form of a pop-up box.

Reproduction or publication of this manual without the express written consent of CNC Innovations, LLC. is
prohibited. No liability is assumed with respect to the use of the information herein.

Focal*Point DNC, Focal*Point Remote, DNC*Library and DNC*ID are trademarks of
CNC Innovations, LLC.

Windows, and its varied forms, are trademarks of Microsoft Corporation.
Printed in the United States of America
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License Agreement

Disclaimer of Warranty and Limited Liability

CNC Innovations makes no warranties, either expressed or implied, with respect to this document or with respect to
the Focal*Point DNC or Focal*Point Remote software products, including any related user information published
by CNC Innovations. Focal*Point DNC and Focal*Point Remote are sold "as is." The user of the product assumes
all risks with regards to the suitability, quality, and performance of the products.

CNC Innovations, its dealers, distributors, agents, or employees shall not be held responsible for any consequential
or incidental damages resulting from use of the products, even if CNC Innovations has been advised of the
possibility of such damages.

Neither CNC Innovations nor anyone else associated with the creation or delivery of the Focal*Point products shall
be held liable for any loss of business revenue, interruption of business activity, or loss of business information as a
direct or indirect result of use of the Focal*Point products.

Some states do not allow for the exclusion or limitation of implied warranties or liability for incidental or
consequential damages, so the above limitation or exclusion may not apply.



3

Installation Considerations

Preparing to Install the Program

In most cases, the installation and setup of Focal*Point is quite simple. Usually the only consideration is that the
installation and first-run of the program be performed with local Administrative rights. This will ensure proper
installation, configuration and licensing. Also note that day-to-day users may also need read/write/modify privileges
for LAN drives (shares) to ensure that the Focal*Point program has proper access to the machine NC program files.
This is especially true when configuring Focal*Point in a Multi-User environment that uses a "shared" database,
located on a LAN drive.

Depending upon your network and related Group Policies, as well as the local PC operating system, it is not always
easy to confirm full administrative read/write/modify permissions. Consult your IT manager for assistance if
corporate Group Policies prevent successful installation and licensing.

Installations targeted for Windows Vista and above may have additional concerns. These operating systems do not
provide full runtime privileges even when started by an administrative user. As such, and before starting the
installation process, it is best to right-click the setup program and select the "Run as Administrator" option. After
completing the installation program you should have a program launch icon located on your desktop and also in the
Focal*Point program group located in the Start>Programs list. Right-click either (or both) of these icons and again
select the "Run as Administrator" option to run the program for the first time. This is an important first-step as the
program is still in the configuration and licensing stage. Complete the initial configuration and licensing as directed.

If multiple users will have PC login and startup rights for Focal*Point, it is best to provide on-going Administrative
privileges to all users. This is done by right-clicking the Focal*Point shortcut and selecting the Properties option.
From the Properties page, view the Shortcut tab and click the Advanced button and ensure that the Run as
Administrator option is checked. Next, view the Compatibility tab and, if available, select the option "Change
settings for all users." Additionally you may wish to set compatibility mode for Windows XP (Service Pack 3).

System Permissions

Please Note that although Focal*Point's installation program adds the necessary "Everyone" user group to its main
working folder, named CNCINNOV, the following information is provided for IT professionals that may wish to add
their own groups and privileges as required by company policies and procedures.

In the event that several Standard Users (PC users with limited rights) will have login ability, it is easier to grant
read/write access to such users with Windows Security options as shown below.
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As seen in this "Windows 7" example, all Authenticated Users (Users with a
login name and password) have been given full read/write permissions for the
Focal*Point installation folder and all sub-folders. To access these settings
open the Windows Explorer, right-click the CNCINNOV folder and select the
Properties option. Note that permissions can only be changed by an
administrative user.

It should also be understood that Focal*Point records setup and user configuration information in the system
registry. By default these registry locations usually allow proper access rights, but the location keys are provided
here for informational purposes only. NOTE THAT CNC INNOVATIONS TAKES NO RESPONSIBILTY FOR
CHANGES MADE TO THE SYSTEM REGISTRY.

Although changes are not likely required, the two area of interest are:

HKEY_CURRENT_USER\Software\CNCInnovations
and
HKEY_LOCAL_MACHINE\Software\CNCInnovations

These two keys and all sub-keys should have the permissions discussed above.

Performance Tweaks

 When several RS232 communications hubs are connected to the DNC computer, Focal*Point may start
before all the hubs have fully initialized. This is evident when some connections report a status of Not
Loaded. To remedy the situation the following VB script code can be used to delay the start of Focal*Point
when the workstation is still booting.

'VBScript to delay starting Focal Point
'Change WaitTime seconds to meet your needs
'Also verify the execution path in the last line
Const WaitTime = 120 'Change number of seconds
Dim WshShell, btnVar
Set WshShell = WScript.CreateObject("WScript.Shell")
btnVar = WshShell.Popup("Focal Point will start in " & WaitTime & " seconds." & VbCrLf _
& "Or click OK to continue", WaitTime, "Starting DNC")
'Make certain the following execution path is correct for your installation of Focal Point
WshShell.Run "c:\cncinnov\fpdnc\focalpt"

 Be sure to check Power Saving settings for local harddrives and monitors, as well as, screen savers before
attempting Drip-Feed operations.

 Avoid Buffer Over-flow errors during Drip-Feed operations by setting COMM Port hardware properties to
disable FIFO buffers. See your hardware manufacturer for specific instructions. To change the native
COMM port settings (COM 1) follow these general procedures

Right-Click the My Computer icon and select Manage
Select Device Manager from the Computer Management page
Expand the Ports (COM & LPT) section
Double-click COM 1 to display its Properties
Click Advanced on the Port Settings tab
Set the Buffer sliders to their lowest setting or Disable the Buffers .
Reboot the PC

This setting may also solve the
problem displayed as "Error
Updating Local Database /
Error Number = 1" when
Standard Users start
Focal*Point for the first time.
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Windows 7 & 8 Security Considerations

Important

Windows 7 & 8 , as well as Vista, contains several new security enhancements that impact the way programs
interact with the user and the operating system. To avoid complications while configuring and testing Focal*Point,
CNC Innovations highly recommends that first-time users run Focal*Point with an Administrator account and that
User Account Control (UAC) be set for the Never Notify option. By default, the first account created on Windows 7
& 8 will be an Administrator account. You can either use this account for setup and testing or create a new
Administrator account. Do not attempt initial testing with a Standard User account.

Please keep in mind that Windows security features are an on-going project with Microsoft and are subject to
change. The information discussed below is relative to the first release of Windows 7 and may very well change as
operating systems mature.

Before proceeding, make certain that system permissions have been changed to allow the logged in user
(Authenticated Users or specific user accounts) complete read and write permissions as shown in the previous
Installation Considerations section. Warning: do not assume that the Administrator account will provide the
necessary permissions because even Administrators operate with Standard User permissions when running most
applications. In fact, that is the purpose of the new security enhancements--to restrict full access to files and the
operating system.

The User Account Control settings are located in the Control Panel > User Accounts section. At the User Accounts
home screen click the option to Change User Account Control Settings and set the option for Never Notify as shown
below.
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How User Account Control (UAC) Limits Focal*Point OperationT

 When UAC is active it will prompt the user for an acknowledgement each time Focal*Point is started. If
Standard Users start Focal*Point it may also require an Administrators password in order to proceed.

 Unlike earlier versions of Windows, UAC will stop Focal*Point from running automatically when placed
in the system Startup menu. Only by setting UAC to Never Notify will this important function be possible.
Search Windows help for instructions to add Focal*Point to the Startup menu.

 As of this writing Windows 7 and all future versions of Windows will only run programs as "Service" in
the Session 0. This means that the user interface is not immediately available to the user. If running as a
service is important to you we highly recommend the use of a service manager program such as
FireDaemon Pro. Service management software provide significantly better tools for running and managing
service applications. Please refer to the Focal*Point installation CD for detailed instructions and tips.

 Access to file server mapped drives must be configured with Administrator rights. This is true even when
changing an existing drive's UNC path location.

 Mapped network drives (Workgroup PCs only) will not be available without some form of user
intervention. This problem may not be evident to casual observers since mapped drives do appear
connected when accessed from the My Computer console. The problem is that these drives remain
inaccessible when software applications attempt to use them. Although Focal*Point will warn of
connection problems at startup, the situation and solution are none-the-less quite annoying. This is
especially true when you consider that Focal*Point's Multi-User Administration, DNC Program Library
(including open file dialog boxes), the Received File Administrator, Automatic Library Transfer, and File
Archiving may all refer to mapped drive locations.

Symptoms and Solutions for Inaccessible Drives due to activated User Account Controls

If Multi-User Administration (Settings menu) is enabled and points to a mapped drive location, Focal*Point
may report an error activating the form during startup. Focal*Point's error log will contain the following
entries.

Error Location 174 Err = 76
Error Location 172 Err = 3044

This error can be resolved in several ways. The first is a quick work-around. During startup when
Focal*Point displays the message that you appear to be using the shared location for the first time, simply
click the Cancel button to run Focal*Point in local mode. If you then open the File menu and select Send
(browse), you will be shown a listing of all drives. Inaccessible drives display with a large red X through
them. If you click the shared drive it will open normally and will remain accessible for the remainder of
your windows session. If you exit Focal*Point and restart, it will run as expected.

A better and more permanent way to solve this problem is to set the Multi-User shared location with a
Universal Naming Convention (UNC) path rather than the usual mapped drive location. The first step is to
establish a connection as described above and then use the Multi-User Advanced button to enter the UNC
path. UNC paths are specific to your network but typically take the following form,
\\ServerName\FolderName. This method works well because network shares are not affected by UAC
settings, to date Microsoft only restricts mapped drives.

UNC paths work very well when you simply need to designate a shared folder location for Focal*Point's
working database. However, there may still be additional considerations. If your Local Area Network uses
mapped drives versus local folders for the storage of NC programs, you will still have a problem accessing
these files from within the DNC program library. Note that this restriction impacts Sending, Receiving,
Remote Program Requests and Editing. To test this condition, simply double-click the DNC ID for an
established library entry. If the editor fails to open the file it is an indication that the drive mapping has
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failed. Again a simple correction is to click the Send button and attempt to browse the inaccessible drive.
The drive will then be accessible for the remainder of your Windows session.

As shown by the discussions above, User Account Control impacts Focal*Point's operation in several ways. It is for
this reason that CNC Innovations warns against using UAC during the initial setup and execution of Focal*Point.
However, recognizing that some companies will want to take advantage of the increased security that UAC offers,
and the possibility of running Standard User accounts, we offer the following for informational purposes only. Note
that It is not the intent of CNC Innovations to provide help for Windows operating systems. For additional
information please refer to the Windows Help program, newsgroups, blogs, and Microsoft support.

Since the release of Windows Vista, Microsoft has acknowledged and defended the reason for restricting mapped
drives as discussed above. To that end Microsoft has issued a knowledge base article discussing the situation. Please
refer to http:\\support.microsoft.com/kb/937624

Tip: As of this writing, enabling mapped drives in Windows 8.1 can only be accomplished using the
"EnableLinkedConnections" registry modification as discussed below.

As stated by Microsoft: (For Windows Vista and 7)

"The article briefly describes the drive mapping situation when UAC controls are enabled and
provides the following work-around. Use the net use command together with a UNC name to
access the network location. For example, at a command prompt, type the following command,
and then press Enter:"

net use \\<computername>\<sharename> /user:<username>

If you are particularly ambitious and rushed off to try the above example you found that it did
not work as listed. The Microsoft article provides a very generalized example that must be
modified to account for mapped network drives not being available, which is the case for
Focal*Point and other programs that rely on mapped network shares. For example, suppose that
your Focal*Point multi-user share location and NC programs are contained on a network drive
share such as \\Companyshare\DNC, which is mapped to drive H:.

First open notepad and create a desktop file named Enablemaps.cmd, and enter the following
command

net use H: \\Companyshare\DNC [user Password] /user:<username> /Persistent:YES
Pause

 You must substitute Companyshare\DNC with the server and location used by your
network.

 [user Pasword] should be the password of the user with rights to the share location

 <username> is the name of the user with rights to access the shared location.

 Persistent merely keeps the share active and Pause keeps the command window open
until the Enter key is pressed. In other words you can verify that the command was
successful.

http://support.microsoft.com/kb/937624


Here is how the command line might look:

net use H: \\Companyshare\DNC 1234 /user:Joe /Persistent:YES (If the share location
contains spaces add quotes - "\\Company Share\DNC Programs" )

Points to remember before starting Focal*Point:

 If the local user is part of the administrator group, it is important to right-click the file and
select the "Run as Administrator" option.

 I the user is standard simply double-click the file to run it.

 The mapped drive will remain active for the entire Windows session, but it will be
necessary to run the program every time Windows is re-started.

EnableLinkedConnections (Required for Windows 8.1)

As an alternative to the above work-around, Microsoft has a technet article showing a registry change to accomplish the same
results without having to run a separate command file.

http://technet.microsoft.com/en-us/library/ee844140%28v=ws.10%29.aspx

The solution requires a small change to the Windows' registry to Enable Linked Connections. CNC Innovations has successfully
tested this work-around using a Windows 7 administrator account.

To co
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Typical Preliminary Warnings from Microsoft

WARNING: If you use Registry Editor incorrectly, you may cause serious problems that may require you to
reinstall your operating system. Microsoft cannot guarantee that you can solve problems that result from using
8

nfigure the EnableLinkedConnections registry value, follow these steps:

Click Start, type regedit in the Start Search box, and then press ENTER.
Locate and then right-click the following registry subkey:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System
Point to New, and then click DWORD Value.
Type EnableLinkedConnections, and then press ENTER.
Right-click EnableLinkedConnections, and then click Modify.
In the Value data box, type 1, and then click OK.
Exit Registry Editor, and then restart the computer.

ed Drive Timeout

ditional and yet related problem occurs when a Server or PC has shared network drives. The mapped drive may be
nnected after a regular interval of inactivity, and Windows Explorer may display a red "X" on the icon of the mapped drive.
ver, if you try to access or browse the mapped drive, it reconnects quickly. This behavior occurs because the systems can
dle connections after a specified time-out period (by default, 15 minutes) to prevent wasting server resources on unused
ns.

ituation may cause Focal*Point to error in cases such as a remote file request for a program located on a previously
cted network drive. For more information see http://support.microsoft.com/kb/297684

again this fix requires a change to the Windows' registry, which as always, is not recommended by Microsoft. For your
nience the registry entries are listed below

Registry Editor incorrectly. Use Registry Editor at your own risk.

http://technet.microsoft.com/en-us/library/ee844140%28v=ws.10%29.aspx
http://support.microsoft.com/kb/297684
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Extract from Microsoft KB297684

To resolve this behavior, change the default time-out period on the shared network computer. To do this, use one of the following
methods.

Use Registry Editor to increase the default time-out period. To do this, follow these steps, and then quit Registry Editor:

NOTE: You cannot use this method to turn off the autodisconnect feature of the Server service. You can only use this method to
change the default time-out period for the autodisconnect feature.

Click Start, click Run, type regedit (Windows 2000 or Windows Server 2003) or type regedt32 (Windows NT 4.0),
and then click OK.
Locate and then click the following key in the registry:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\lanmanserver\parameters
In the right pane, click the autodisconnect value, and then on the Edit menu, click Modify. If the autodisconnect value

does not exist, follow these steps:
On the Edit menu, point to New, and then click REG_DWORD.
Type autodisconnect, and then press ENTER.
On the Edit menu, click Modify.
Click Hexadecimal.
In the Value data box, type ffffffff, and then click OK.

NOTE: The client-side session is automatically disconnected when the idling time lasts more than the duration that is set in
KeepConn. Therefore, the session is disconnected according to the shorter set duration value between AutoDisConnect and
KeepConn. To change the time-out duration in the client-side during a UNC connection, specify the arbitrary time in KeepConn.

Locate and then click the following key in the registry:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Service\lanmanworkstation\parameters
Value: KeepConn
Data type : REG_DWORD
Range : 1 to 65535 (sec)
Default value: 600 sec = 10 mins

Command Line Method

NOTE: If you use this method, you may turn off the autotuning feature for the Server service.

To change the default time-out period for the autodisconnect feature of the Server service, open a command prompt, type the
following line, and then press ENTER

net config server /autodisconnect:number

where number is the number of minutes that you want the server to wait before it disconnects a mapped network drive. The
maximum value for this command is 65,535.

NOTE: If you set the autodisconnect value to 0 (zero), the autodisconnect feature is not turned off, and the Server service
disconnects mapped network drives after only a few seconds of idle time.

To turn off the autodisconnect feature, open a command prompt, type the following line, and then press ENTER:

net config server /autodisconnect:-1
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LICENSE REQUEST FORM

Focal*Point Software License

To prevent unauthorized use of Focal*Point the software requires a license key in order to function beyond the
initial 10-day, free trial period. To obtain the license code (password) it is best to e-mail the unique PC Seed
code that is displayed within the Manage License console to info@cncinnov.com. In cases where the end-user
does not have access to e-mail, this form may be printed and faxed to CNC Innovations. (The code can also be
sent from CNC’s web at HTUwww.cncinnov.comUTH -Contact us). Be sure to list the PC Seed code for each seat
(workstation) where Focal*Point is installed. The completed form should be faxed to CNC Innovations at 508-
523-1763. CNC Innovations will provide the required License Password(s) and return the form.

Important - After entering a license password do not delete or un-install Focal*Point without first contacting
CNC Innovations for important license deletion instructions and validation.

Contact Name ______________________ Tel. Number _____________________________

Company Name ______________________ Fax. Number _____________________________

Total Seats Purchased __________ Total DNC Ports Purchased ____________

1. Machine Name/Number ________________________________ Number of DNC Ports ________

Seed Code* -- -- -- -- --

Password** -- -- -- -- --

2. Machine Name/Number ________________________________ Number of DNC Ports ________

Seed Code* -- -- -- -- --

Password** -- -- -- -- --

* The Seed Code is displayed within the Manage License Console.
** The Password Code is supplied by CNC Innovations and entered License Console.

CNC Innovations, LLC.
P.O. Box 327 - Auburn, MA 01501

Tel: (508) 523-1763 Fax: (508) 892-0378

http://www.cncinnov.com/
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Transferring and Removing a Software License

Transferring a Software License

The Manage License console provides a method for CNC Innovations to validate the removal of a software license.
Performing this action requires special codes and instructions, which will be supplied by calling CNC Innovations at
508-523-1763. After a valid license removal, a new license will be issued.

Do not delete or un-install Focal*Point without first contacting CNC Innovations for important license removal
instructions and validation.

When calling CNC Innovations to transfer or remove a license, be prepared to supply the existing Seed and
Password codes, which are both displayed in the Manage License console. The console is accessed when starting
Focal*Point and is also located in the Help menu.
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Help Menu Items

In addition to the Help program link, this menu contains links to the Focal*Point's license manager as well as a
backup function to collect and save the various database and log files used by Focal*Point. The License Manager
section, which is also accessed via Focal*Point's startup splash screen, provides the tools for creating the initial 10-
day license and also for updating the system password with additional machine port activations.

As noted above the Help menu contains a function located in the section labeled Back Up My Files. Click the
Backup System Files option to collect the current configuration files. These include the FPlocal.mdb that contains
machine communication parameters, the FPShare.mdb which host the DNC Library and various other parameters,
and the Connect.mdb that coordinates seat login status and identification of received files from the various host PCs.
Also included in the backup are various system log files which may be helpful to CNC Innovations during
troubleshooting operations.

After running the backup, another link option allows the user to open and inspect the folder containing the collected
files. This allows for easy archiving of the system files to another location in the event of a PC failure. Saving these
files allows you to rebuild a Focal*Point workstation in a matter of minutes versus the alternative which may
include weeks of testing and troubleshooting.
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Technical Support

Eligibility

When you purchase the Focal*Point DNC system from CNC Innovations, LLC. you are eligible for free, product-
specific, telephone technical support for a period of 30 days from the date of purchase. Supplemental technical support
is available both on a pre-paid hourly basis and through the purchase of our Comprehensive Service Agreement.

Scope

Focal*Point runs on Microsoft Windows operating systems. It is therefore expected that you have a basic
understanding of using Windows based software. It is also assumed that you know how to configure and use the
communications options on your machine controls.

We will be happy to answer any relevant questions you may have about using our products, but we reserve the right
to limit technical support to our applications and functionality only. For example, we will work with you to help
you configure Focal*Point's communications parameters to match those of your machine control, but you must
know the current settings on the control and/or how to change those settings.

If your problems go beyond the application and functionality of our product, you may contract with us for
Supplemental Technical Support.

Before contacting CNC for technical support, please print a copy of the Technical Request Form, located at the end
of this document, fill-in the requested information, and fax it to CNC's Tech. Support at 508-523-1763.

Supplemental Technical Support

CNC Innovations, LLC. provides supplemental technical support for most machine communications applications on
an hourly basis. This is available by telephone or on-site. To obtain technical support contact CNC Innovations,
LLC. Technical Support at 508-523-1763.
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System License and Configuration

Product Selection and License

Focal*Point provides several configuration / licensing options. After the initial installation, the mode of operation
must be indicated prior to requested a password key. The modes of operation are as follows.

Multiple Port DNC plus Administrative Functions

This is the standard operating mode when Focal*Point is used as a DNC host connected to multiple machines. This
mode is used when several activated machine connections have been purchased with the intent of utilizing external
RS-232 communications hubs. Administrative functions are defined as having access to the NC program database,
Parts and Operations, and the Received File Administrator.

Data Collection Services Only

Provides configuration for licensing Data Collection services only. DNC program transfers will not be supported

Single Port DNC plus Administrative Functions

This mode is popular as a replacement for CNC’s Easytalk DOS software and for situations where multiple
machines with different communications parameters must be configured for use with a single-port laptop computer
or when a single-port PC will connect to multiple machines using an A/B style switchbox. This mode of operation
requires that the user select a desired machine prior to performing I/O functions and is therefore not recommended
for automated program transfers.

Administrative Functions Only

This mode is generally used in conjunction with Multiple Port DNC installations as if affords NC programmers
and system administrators the ability to maintain the NC program database, received program files and numerous
other administrative functions. This mode does not provide communications with machines.
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Single User Screen

Single User/Single Port Display Screen

The above screen is displayed whenever Focal*Point is licensed and configured for Multi-Port DNC but using only
a single COM port. It is designed to accommodate installations that use stand-alone computers for each machine
center. The displayed selection buttons will invoke the same modules and functions as their counterparts in the
standard Multi-Port configuration.

For situations that require a connection to many machines through a single COM port we recommend the "Single
Port DNC with Administrative Functions" license configuration



8

Single Port Screen

Single Port DNC Mode

The above screen is a representation of selecting the "Single Port DNC Plus Administrative Functions"
mode of operation. This is one of three modes offered in the Settings>Configuration menu. This mode and
license configuration is popular for situations where multiple machines with different communications
parameters must be configured for use with a single-port laptop computer or when a single-port PC will
connect to multiple machines using an A/B style switchbox.

This mode of operation also requires that the user select a desired machine prior to performing I/O functions
and is therefore not recommended for automated program transfers. As shown in the depiction above, many
machines are listed and each may have its own set of communication parameters as configured in the
Settings>Communications section. To select a machine simply highlight the entry and click the "Use
Selected Row/Machine for DNC" button. This action will activate the machine communication parameters
on the selected COM Port.

To transfer a program to the machine click the "Send" button and select a file from the list of programs
released to the machine. Note that a filtered list requires the use NC Program Categories, which are used
when importing programs into the DNC program library and as such become associated with and all
machines tagged for that category.

The only significant difference with this mode of operation and the standard Multi-Port DNC mode, which
connects many machines to dedicated COM Ports, is the restriction of activating only one communications
port at any given time. All of the remaining features and functions of Focal*Point are still active. This means
that it is still possible to perform remote file requests so long as the machine has been activated previously.
This is helpful and eliminates wasted time when multiple programs will be transferred in or out of the
machine.
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Administrative "Only" Screen

Administrative Screen

The Administration "Only" screen is displayed when Focal*Point is licensed and configured with no
communications ability. This mode of operation is used by programmers and floor managers and provides all
necessary functions to maintain the DNC program library, Parts and Operation database and the Received File
Administrator. This license configuration assumes a role in a larger "shared" DNC network where administration is
required amongst several individuals. This configuration cannot be used with Focal*Point Remote software.
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Program Overview

Focal*Point is a powerful Windows based, shop automation tool. It combines Distributed Numerical Control
(DNC) with file management, editing, archiving, and the ability to catalog parts and machine operations for
paperless shop automation. By combining these features your sales department can focus on parts while
programmers supply drawings and NC programs. Your production manager can track current operations, and QA
can certify program revision tracking and archiving to ensure the CNC operator of up-to–date programs.

CNC Innovations offers Focal*Point as a means to fulfill DNC and shop automation needs. As the program
continues to evolve, you can be sure the focus will always be toward increased productivity in compliance with ISO
requirements and certification.

Main Program Display

The main screen of Focal*Point is an interactive display of the Port Number, Machine Name,
NC Program and DNC*ID, as well as Port Status and Byte Count for the current operation.

Adjust grid widths on the main screen, the DNC*Library, the RFA, and in several other locations. For example,
expand the program and path view to see the entire program location or perhaps an expanded DNCID column will
suit your needs. More often you may want to resize grids for the DNC*Library in order to view, say, program
revision number information rather than the program's location. Since your desktop form size may differ from the
Maximized window, Focal*Point may require grid resizing for each of the views. However, once set you will no
longer need to resize your preferred setting when clicking between desktop and maximized view.

The Defaults menu allows you to restore default views for individual screens or for the entire program. Along the
top menu you will also see at a glance when the FTP server has been activated, and for Focal*Point "Single" users,
the machine connection activation button has been moved to the main menu to eliminate confusion with the port
reset button. Lastly, when calling for program support, your Focal*Point configuration is prominently displayed in
the form title.

Multiple User Environment

Focal*Point is designed to integrate the tasks of several users within a multi-user, shared environment. A typical
installation will have one or more DNC host seats, each providing all administrative functions and full machine
communications. Additionally, Administrative "Only" seats provide easy management of Focal*Point's
DNC*Library, Receive File Administrator, and Parts & Operations database.

Another feature termed Automatic Library Transfer allows UanyU LAN workstation (no license required) to
automatically add NC programs to the DNC*Library. This feature will also maintain a history for every auto-
transfer operation. Revised programs returned from machine operators are held in a special folder for easy
identification and review. Program revisions deemed essential may be selected to overwrite original programs, and a
special archive folder will backup the program for ISO compliance.

With these powerful administrative functions, CNC Innovations' Focal*Point DNC not only provides a means for
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easy access to approved NC programs but also simplifies revision tracking while offering a paperless method for
distribution of related program documentation.

Display Buttons

The main display screen also hosts a number of shortcut buttons for opening the DNC*Library and Receive File
Administrator, as well as manual Send and Receive file functions. Before transmitting files, first highlight the
desired machine connection (if necessary, scroll the machine display using the Up and Down Arrow keys)
then select either the "Send" or "Receive" button and follow-through with the file selection or naming process.

Since the majority of machine controls can take advantage of Remote File Requests and upload files automatically
through the Receive File Administrator, the "Send" and "Receive" function buttons are generally used for controls
with specific communication protocols or for those that cannot output file requests. In the latter case, CNC
Innovations offers remote terminal keypads to facilitate the file request procedures.

The "Set Inactive/Active" toggle button will close all communications on the selected port connection. This is a
useful tool for resetting the communications port or for preventing unauthorized remote file transfers.
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Focal*Point
Program Setup

Focal*Point is a highly versatile DNC communications program with a host of features ranging from simple point-
and-click file transfer to complex network integrated file maintenance. These features, plus the inherent security of a
well-maintained LAN network, require a complete understanding of the setup and configuration of the software.

For this reason, it is recommended that both the installer and a LAN Administrator review the Multi-User
Administration, Defaults, and Automatic Library Transfer sections of the Help Topics before proceeding with the
software installation.

Setup Overview

The following procedures describe the steps required to install and setup Focal*Point and any additional seats that
will be used for DNC administration functions. It should be noted that since Focal*Point can be purchased as a
single seat, single port communications package or as an extensive multi-port DNC system with a multiple
administrative workstations, there are different setup strategies for each situation.

If you have purchased Focal*Point as a single computer, single port, file manager and editor, you need only install
the program by running the setup program from the installation CD and then proceed to the setup instructions below.
The only optional point to consider is LAN Connectivity, which is the subject of the next section.

Multi-User Administration (LAN Connectivity)

When Focal*Point is installed as a DNC host with at least one administrative seat, only one workstation should be
used to construct the main DNC*Library, the Parts and Operations database, and the NC Program Categories, which
are essential to the fundamental operation of the system. This action, plus the setup of the communications section,
will satisfy the initial installation of the system and allow for the immediate transfer of NC files.

Keep in mind, to ensure equal access to files in a multi-user environment, always store NC (library) files in a
common LAN directory that is mapped with a common drive letter. Furthermore, since the DNC*Library database
stores the name and location of imported program files, you should not move files from their location after the
DNC*Library is built.

Although the Multi-User Administration feature allows multiple workstations to access the DNC*Library, only one
site can have "locked" access to the library at any given time. (Locked access is defined as performing global
deletions or modifications.) This is a common but necessary restriction that is used to ensure integrity of the system.
This simply means that when a user has finished importing programs into the DNC*Library, he or she should
remember to close the library and thereby allow other users have shared access to the library.

Installation Instructions

 Since a common (shared) point of access is required for both the DNC host and a DNC Administrator, you must
select an appropriate drive and directory on the LAN network where files will be accessed. It is in this directory
that Focal*Point will build and maintain its file library and parts database. Focal*Point DNC hosts
(workstations having communication ports) will store received files in this directory and query the library
database when processing remote file requests.

After designating the shared LAN directory, make certain that all workcenters, administrators and hosts alike,
have sufficient read and write access the targeted LAN directory.

 Install Focal*Point on any workstation by running the install program from the CD's master setup program, or
run the setup utility on disk 1 of the installation disks. During the installation process, be sure to select the
computer's local hard drive as a destination directory for the Focal*Point program.

For example, selecting drive ‘C’ will install to C:\CNCINNOV\FPDNC, which is a hard coded destination
directory.
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 From Focal*Point’s main screen select Settings|Multi-User Administration from the menu bar and click the
"Enable LAN Connection" check box. Now browse for the Shared Files (LAN) Directory as displayed on the
center of the connectivity screen. (The Shared Files Directory is the common LAN directory discussed in the
first step.) Finally, enter a unique Cell Name that will identify the seat as a unique entity in the DNC network.

Now repeat the installation for all remaining seats and, again, connect to the Shared Files (LAN) Directory as
discussed earlier. Complete the program setup by exiting and re-starting the program.

This concludes the basic installation of Focal*Point with its Network*Overlay administrative capabilities. The
next section outlines the preferred setup steps to begin file transfer operations.

Setup Instructions

The following procedure is recommended by CNC Innovations and will provide the quickest route to establishing
communications with your machine controls.

Enter your NC Program Categories

Program categories allow Focal*Point to format reports, add security to file transfers, and aid in the creation
and sorting of the DNC*Library. Essentially, the NC Category is a tag applied to your machine control(s)
communication parameters and NC program files, and serves to unite the files with specific machines. To input
these categories, select Settings|NC Program Categories from the main menu and enter all of the categories
(file/machine types) that will be used in the DNC system. Note that if the entered categories are highly specific,
that is, they apply to only one machine, then only that machine can request programs imported for that category.
If, however, the categories are more generalized, then many machines can be configured (tagged) to share the
same file type. For example, a category called "Lathe" would be appropriate for sharing files among many
machines that share the "Lathe" category. See the Communication Parameters section for applying categories to
machines, and the DNC*Library for importing files within a specific program category.

Build your DNC*Library

The DNC*Library is a database listing of every file that is used in the DNC system. It also contains a DNC
IDentifier (DNC*ID) that will be used for all remote file requests. To build the library, select Database|DNC
Library from the main menu and select the "Add Entry" button, or better yet, pull down the Libraries file menu
and select "Import Directory" to begin adding NC programs to the main DNC*Library. The "Add Entry"
function will add single files to the library while "Import Directory" will add many files. Note: This operation
will not duplicate NC program files; it merely builds a list pointing to the location of the files. Furthermore, if
additional files are added to your program storage folder, re-running the import function will not duplicate
existing library entries. It will only add the new entries.

Note that at this point, you can start file transfer operations if the required RS232 parameters are set.

Enter your Parts and Operations (Optional)

After building the Library, select Database|Parts and Operations from the main menu and enter the part numbers
and customer information for each part you manufacture. Include the part revision number and graphic drawing
if they are available.

After entering part numbers, highlight the first part number and click the "Operations" button. From the
displayed operations entry screen you can add all of the operations used to complete the finished part. As each
operation is added, you can specify a DNC Resource file as well as any additional graphics or setup sheets. To
add a DNC Resource file simply click the "Add DNC File" button from the Resource Actions section and
browse for the appropriate file. To add additional resources click the "Add" button.

Repeat the above steps to add the operations for each part entered in the Parts library.

Hint: Clicking the "Detail" button will display another handy screen that can be used for entering operation
details.
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UPrint Reports

That's it! Select Print Ops to generate a hard copy of the Parts database. Printed reports are also a handy
reference for the DNC*ID numbers that will be used for remote file requests.

Program Transfers

If you haven't already done so, you must configure each Focal*Point DNC host to communicate with each control.
This is readily accomplished at each by opening the Settings|Communication Parameters section and entering the
RS232 parameters required for each machine control.

For more information about RS232 parameters, remote file requests and general file transfers, please refer to the
Communications Parameters section of the help program and user manual.

Buffer Overflow Warning

When Focal*Point is configured to use the host computer's local serial ports (Comm 1 & 2) or with many USB and
PCMCIA serial adaptors, it is important to adjust the "transmit" and "receive" buffers (FIFO) for the serial port
hardware. Note that these buffers are not always available and at times may not actually work as described on low-
cost hardware. If the default settings are not adjusted you may experience a buffer overflow problem while loading
NC programs on older controls.

Resolving The Buffer Problem

To configure your serial port(s) use the following procedures.

Right-Click the My Computer icon and select Manage
Select Device Manager from the Computer Management page
Expand the Ports (COM & LPT) section
Double-click COM 1 to display its Properties
Click Advanced on the Port Settings tab
Set the Buffer sliders to thier lowest setting or Disable the Buffers .
Reboot the PC
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Program Navigation Keys

General Navigation Keys

ALT Displays main menu items such as, File, Settings, Database, Help (F, E, D, H) Use the
ALT key in combination with any underlined letter. For example, ALT - F will open the
File menu, ALT - E opens Settings, ALT - S the Send dialog. ALT - R the Receive
dialog and ALT - L is the DNC Library.

Enter Selects the currently highlighted item or menu selection.
F1 Opens the Focal*Point help screen
UP Arrow Move up one item within a display grid or menu item. Also used to sort table items

based on the highlighted column. For example, within the Send, Receive, or Library
form, highlight DNCID and press ALT - UP Arrow to sort in ascending order.

ESC Exits the current operation.
ALT-F4 Closes the currently active window. Same clicking the X button
ALT-
SPACEBAR

Displays the System menu to select MIn, Max, Close etc.

ALT-TAB Switch between currently active applications
DOWN Arrow Same as Up Arrow but sorts in descending order.
LEFT Arrow Move the cursor left within a table or menu. Will also move left within a tab sequence

order.
RIGHT Arrow Move the cursor right within a table or menu. Will also move right within a tab sequence

order.
PAGE UP Move the cursor up by one page within a table
PAGE DOWN Move the cursor down by one page within a table.
CTRL - F Opens the search dialog for items within the currently highlighted column.
TAB Cycles through all available items
ALT - U Used by Focal*Point-Single to activate the currently highlighted machine for DNC

operations.

Multiple Keys Entries

ALT - F, O Main Screen Operation - Opens the sample or operating database menu.
CTRL - E Main Screen Operation - Opens the NC file editor
ALT - F, S Main Screen Operation - Opens the Send Browse function.
ALT - F, O Main Screen Operation - Opens the Focal*Point exit menu.
ALT - E, G Main Screen Operation - Opens the Configuration menu.
ALT - E, D Main Screen Operation - Opens the Defaults menu.
ALT - E, N Main Screen Operation - Opens the Program Categories menu.
ALT - E, C Main Screen Operation - Opens the Communications Parameters menu.
ALT - E, U Main Screen Operation - Opens the Form Labels menu.
ALT - E, M Main Screen Operation - Opens the Multi-User Administration menu.
ALT - E, S Main Screen Operation - Opens the Security menu.
ALT - D, D Main Screen Operation - Opens the DNC File Library database.
ALT - D, P Main Screen Operation - Opens the Parts and Operation database.
ALT - D, R Main Screen Operation - Opens the Receive File Administration
ALT - F, E DNC Library Operation - Opens a selected entry in the file editor
ALT - F, V DNC Library Operation - Opens the library file verification operation.
ALT - F, D DNC Library Operation - Opens the file import menu.
ALT - F, I DNC Library Operation - Inserts the DNC ID comment line within files for the selected

Library category.
ALT - F, R DNC Library Operation - Removes the DNC ID comment line within files for the

selected Library category.
ALT - N, Down DNC Library Operation - Moves down within the DNC Library "Find" menu.
ALT - N, Right DNC Library Operation - Moves right to access a sub-menu in the DNC Library "Find"

menu.
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Program Performance

Focal*Point provides a number of log files used for recording program activities. These log files include the FTP
activity log, Auto Library Transfer log, Database Optimizer log, Program Error log, Duplicate DNC ID log, as well
as, Send File and Archive File history. The contents of these log files can be viewed and printed from within the
View menu. It should be noted that depending on your system configuration, over time, some of these logs and
history files may grow to a significant size and should be maintained on a regular basis. This is especially true for
Send File History and Archive File History as this information is stored within Focal*Point's operating database.

Each of these log files and history records are easily maintained via the View menu. Simply select a history or log
file and either delete its contents or, if provided, purge the history up to a desired date. Additionally, whenever a
purge action is performed it is highly recommended to compact the database which will help maintain system
performance. To manually compact the database files all users must exit Focal*Point. Next, open the compact utility
by clicking the DBOptimizer link located in Start Menu > Focal Point program group and click the options to both
Repair and Compact the database.

DBOptimizer Database Utility

Tip:

The Repair and Compact functions can be automatically run on regular basis by adding the task to the Windows
Scheduled Task service. It is best to create the scheduled task to run during the evening when all users are logged
out of Focal*Point. Also be sure to create a separate task for both the repair and compact function as shown below.

Important: Do not attempt to run both tasks at the same time--create separate start events while providing ample
time to complete each function. It is also best to run the check and repair function before the compact function. The
DBOptimizer will suppress the usual message boxes and record the event in the DBOptimizer log file.

To check and repair the database run the command line <drive>:\cncinnov\fpdnc\FPUtils.exe <space> Repair.
Where <drive> represents your hard drive and <space> represent the space character. For example:
c:\cncinnov\fpdnc\FPUtils.exe Repair

To compact the database run the command line <drive>:\cncinnov\fpdnc\FPUtils.exe <space> Compact. Where
<drive> represents your hard drive and <space> represent the space character. For example:
c:\cncinnov\fpdnc\FPUtils.exe Compact
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File Menu Options

Open

Clicking the "Open" option will allow the user to select a demo database for viewing and training purposes. This is
the same database that Focal*Point will use when it can’t find an active license on the workstation.

NC File Editor

Focal*Point offers the choice of two internal editors and
one external editor, any of which may be activated by a
simple selection within the Settings|Defaults menu. By
default Focal*Point uses CNC Innovations' standard G-
Force Windows editor. This program, which can be
purchased as a stand-alone application, provides all the
features that experienced programmers and operators have
asked for. In addition to regular editing routines, G-Force
also includes our unique file compare module, which will
quickly find, display, and print all program changes. In
practice, the compare module is generally accessed
directly through Focal*Point's Receive File Administrator
and eliminates the time consuming process of starting G-
Force as a separate program module.

As shown above, the NC editor features a tabbed and
color-coded program display. The colored display can be
permanently configured to highlight specific program
elements or program changes that occur during an edit
session. For details regarding the programs many features,
refer to its on-line help program.

SEND (Browse)

The SEND feature in the File menu will allow a user to select any file from any directory on the computer and queue
it for immediate transfer. Unlike the standard "Send" button on the main screen, this feature does not select files
from within the DNC*Library. As such, it is especially useful for laptop computers that are temporarily setup for
emergency file transfers. For more information, see the section Emergency Backup and Activation Procedures

Exit Selector

As you might expect, clicking the "Exit" selection will immediately close Focal*Point and return control to your
operating system.
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Settings Menu Options

Program Configuration

Focal*Point Product and License Configuration

Product Selection and License

Focal*Point provides several configuration / licensing options. After the initial installation, the mode of operation must be indicated
prior to requested a password key. The modes of operation are as follows.
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.

Multiple Port DNC plus Administrative Functions

This is the standard operating mode when Focal*Point is used as a DNC host connected to multiple
machines. This mode is used when several activated machine connections have been purchased with
the intent of utilizing external RS-232 communications hubs. Administrative functions are defined as
having access to the NC program database, Parts and Operations, and the Received File Administrator.

Data Collection Services Only

Provides configuration for licensiing Data Collection services only. DNC program transfers will not be
supported

Single Port DNC plus Administrative Functions

This mode is popular as a replacement for CNC’s Easytalk DOS software and for situations where
multiple machines with different communications parameters must be configured for use with a single-
port laptop computer or when a single-port PC will connect to multiple machines using an A/B style
switchbox. This mode of operation requires that the user select a desired machine prior to performing
I/O functions and is therefore not recommended for automated program transfers.

Administrative Functions Only

This mode is generally used in conjunction with Multiple Port DNC installations as if affords NC
programmers and system administrators the ability to maintain the NC program database, received
program files and numerous other administrative functions. This mode does not provide
communications with machines.

Remote Socket

By default, this option is not activated, and should only be activated if Focal*Point Remote will be used from a
remote location. Focal*Point Remote is a program for viewing communications activity, setting communications
parameters and resetting Focal*Point's connection ports. The program is commonly used from the shop floor to re-
assign connection parameters when machines are being tested and moved, or for times when it is just necessary to
de-activate or reset a communications port.

By enabling this option Focal*Point can link to Focal*Point Remote via the entered socket connection. Note that
only one connection is allowed at a given time, and the connection will automatically disconnect after a period of
inactivity on the Focal*Point Remote application. If, upon starting Focal*Point, a message is displayed that the
connection could can not be established, there are two common reasons to explore. The first, and most obvious
reason, is that your Firewall is blocking port access. Windows, as well as third-party vendors, will provide a means
to allow activity for the given TCP port/socket number. In the example above, verify that TCP port 49155 is an
allowed connection.

A second problem may be that the requested port is already in use by another application or service running on your
computer. In this case it will be necessary to change Focal*Point's port. Typical TCP port number selections are in
the range of 49152 through 65535. Rather than experimenting to find a free port, it is best to first check which ports
are currently in use on the computer. This is easily done by running the command-line, netstat program. After
opening an instance of the command a prompt--usually located in the Programs > Accessories menu--type the
following.

netstat –ano

This will display a list of currently used ports on your computer (Type netstat /? to see a list additional display
options). Now simply select an unused port number and replace the default port number used by Focal*Point. After
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successfully enabling the option, record the displayed IP address and port number, which must be entered in the
configuration section of Focal*Point Remote.

As one last possibility, according to Microsoft the following error message may be displayed.

"An operation on a socket could not be performed because the system lacked sufficient buffer space or because a
queue was full."

To resolve this problem see Microsoft's article http://support.microsoft.com/kb/196271
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Defaults

System Defaults

System Defaults is a collection of settings and program paths that are used to configure the mode and operation of
Focal*Point. Each category is grouped within a separate tabbed folder. To access individual categories simply click
its tab along the top of the Defaults screen.
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Miscellaneous Defaults

Receive Delay

The Receive Delay instructs Focal*Point to close the current file transfer after a specified time of port inactivity.
This time-out, which is usually set to a minimum period, allows Focal*Point to assume that an incoming program
has been completely transferred. The active port is then reset and placed in Receive Standby.

Send Standby Time-out

The Send Standby Time-out is an override feature for Remote File Requests. Each machine connection may be
individually set to use this timeout by clicking the option in the Advanced Options section of the Communication
Parameters. If enabled, a remote file request will commence transfer after the specified time-out period. This feature
is required only for controls that UDo NotU exert an RTS or X-ON signal when initiating a program load.

Send Standby Purge

The purge delay is a global countdown delay used by any connection that has enabled the Use Send Standby Purge
option located in the Communications Parameters\Options menu. When activated, Focal Point will clear the
communications port if a queued program remains in Send Standby in excess of the specified purge period. Note
that this option is especially useful when Receive File Confirmation is enabled (see Communication Parameters).
The purge feature is also useful on any system where operators mistakenly send multiple file requests before a
program is properly queued. In these situations, the operator is actually buffering the DNC system from receiving
the control’s Xon start code. This causes many operators to mistakenly believe that Focal Point is hung up. With this
option enabled the operator need only wait for the timeout period to expire and then output the remote file request as
if for the first time. It must also be remembered, however, that any remote file request must be completed within the
purge timeout period.

XOFF Reset

The XOFF Reset provides compatibility with different port hardware configurations, i.e., RocketPort and DigiBoard
hardware on `95 or NT platforms. In general, it will not be necessary to change the default "ON" setting. Although,
if you experience port lock-up during remote requests, it may be necessary to change the delay value. Before doing
so, however, it is recommended that you contact CNC's Technical Support staff to verify the nature of the problem
and the proper use of the XOFF Reset function.



23

Port Reconnect Rate

Port reconnect is a function that will activate communications ports for devices such wireless adaptors and single-
port RS-232 hubs that where disconnected or powered down when the Focal*Point software was started. This
important feature is one component of Focal*Point’s wireless optimization. Set the Reconnection Rate to scan
ports at the desired time interval. This feature only affects ports displaying a status of Not Loaded. It has no affect
on ports that have been set to Inactive on Focal*Point’s main screen.

Grid Fonts

When Focal*Point forms are resized or maximized you have the option to resize information within the display
grids, such the Main screen, Library and Receive File Administrator. If fonts are not resized proportionally it allows
more grid detail (machines / library entries) to be displayed. Alternatively, it may be beneficial to allow fonts to
grow to provide better viewing from a distance

Grid Reset

Focal*Point allows you to resize the grid view for most of the major display screens. To reset these screens to the
default value simply click the appropriate button.

Confirm on Exit

An option that will assist in the graceful shut-down of Focal*Point when automating program shut-down and
restart.

The Confirm on Exit option is ON (Checked) by default. It instructs Focal*Point to display a pop-up warning when
exiting the program. The warning simply instructs the user that exiting will close all communications activity.
Typically a user should check for inactivity by viewing the Main screen Status Bar for each machine control before
exiting the program.

There are times, however, when restarting Focal*Point is an automated process, such as when the Task Scheduler is
used to stop and restart the program, or when Focal*Point is run as a service. A common reason for restarting the
program is when wireless or single -port RS232 devices are directly attached and powered by a machine control. In
such cases an evening shut-down of the machine will break Focal*Point's COMM link with the device. Fortunately
Focal*Point has a built in discovery function to activate Not Loaded devices. (Note that this function does not
reactivate a device listed as Rec Stby but which has been previously powered down.)

In short, simply stop and restart Focal*Point prior to the start of, say, first shift and as the machines / RS232 devices
come on-line Focal*Point will automatically activate a new COMM link. Note that the automatic reconnection scan
is based on the Port Reconnect Rate discussed above. For additional information about automated restarts see the
discussion Automating Program Restart
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Default Option Buttons

The Default Menu contains an option to print the default values as entered in each of the default fields. In case of
computer failure these values should be printed and stored along with the Communication Parameters for each
machine on the DNC network.
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NC Viewer / RFA Described

NC Viewer Directory

The NC Viewer application field is used to designate the software used for validating or modeling NC program
code. Although you may specify any software, the application must accept DNC*Library path and file names as a
command line argument.

RFA Save Directory

The Receive File Administrator acts as a watchdog for incoming program files. As such, it offers two options for
saving captured files: save them by overwriting the original program and a 'Save-As' for creating new files. To
simplify the organization of programs when using the Save-As feature, Focal*Point allows you to designate a
default directory and file extension for all Save-As files.

Note: Focal*Point will not create the Save-As directory; it must be an existing directory.
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NC Program Editor

NC Editor Directory

Enter a default directory for use by the NC Editor. This directory does not specify where the editor is located. It only
acts as a default directory for many of Focal*Point's file manipulating functions.

Editor Selector

The editor selector option allows you to choose between Focal*Point's legacy G-Force editor, the current G-Force
editor, or an external editor of your choice. When selecting an external editor be sure to enter its path and program
name in the editor window as shown below. Since a third-party editor is not likely to have a compatible compare
module, use the check box to indicate you choice of the Legacy or Current compare module.

External Editor

Note: When selecting a third-party editor be sure to verify that the program can be run with an NC Program
command line argument.
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Automatic Library Transfer

Automatic Library Transfer (ALT)
Optional

Caution: Focal*Point automatically creates the transfer folders Autolib and Autolib\Err in the FPDNC directory. It
is important that these two folders be used only for their intended purpose. That is, for the automated transfer and
entry of files into the DNC*Library. It is not recommended to use the root folder of any drive since it would be
difficult to prevent users from creating additional files and folders. not related to the ALT function. if you alternate
folders on a common LAN drive are used, make certain that they empty before clicking the "Enable" button.

This ALT function allows any remote LAN workstation to add new NC programs to Focal*Point's DNC Library.
The Transfer folder (shown above) designates the main folder where programmers will place newly created NC
programs. This folder is automatically scanned by Focal*Point and files are processed according these default
settings and also by rules of the ALT function. Be sure to read and understand the functional overview of the Auto
Library Transfer function before activating the ALT feature.

The Log and Error folder is the location chosen for storage of any programs that fail to transfer correctly. Again
there are very specific rules for successful transfer of programs as described in the Auto Library Transfer overview.
This folder also contains a log file named, FPAFT.txt, containing information about both successful and failed
program transfers.

The Relocation folder provides additional functionality and is described below. Also note that since read and write
permissions may be dependant upon user privileges, it is important that this is taken into consideration when setting
up the Focal*Point workstation. Furthermore, when configuring DNC networks with multiple Focal*Point seats,
only ONE workstation can be assigned the duty of scanning the ALT transfer folder. This function is designated
within the Multi-User Administration window of the Settings menu. It will be necessary to enable the LAN
connection, specify a shared folder--which can be the default folder--enter a cell name and finally activate the ALT
administrator role. If the option is grayed out it is an indication that another workstation has already been assigned
the duty.

Additional Notes:

If a machine's communications parameters are configured to use the "Bypass Receive File Administrator" function,
the ALT "Error" folder will be the storage location for any programs that do not contain the requisite DNC ID
comment line. If you find that operator uploaded program revisions are not overwriting the original files as intended,
be sure to check the Error folder and verify that the programs contain the DNC ID comment line according the ALT
rules. (A related feature for using Bypass RFA is located in the Archive tab as described below.)
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Default Processing Explained

By default the Delete files section will be empty and the Transfer rule will be applied to files using the dot wildcard
(.*) designator. Using these settings all files placed in the Transfer folder will be processed according to three
comment lines which should be located within each program. If a program transfer fails the file will be moved to the
Error folder and a log entry will be created.

If it is known that the program posting process will create additional files such as .SS files, they can be tagged for
deletion and Focal*Point will simply delete all files with the .SS extension. Additionally, if your preference is to
save added files they can be moved to the Relocation folder by simply specifying what file extensions qualify for
normal ALT transfers. That is, in the above example, the main transfer folder is first scanned for .SS files. If found
they will be deleted. Next, all files with the .NC extension (notice that the default .* extension has been removed )
will be processed according to the ALT rules. Lastly, any files the do not match either the Delete or Transfer
qualifier will be moved to the Relocation folder. By simply removing the .SS extension all files other than .NC will
be moved to the Relocation folder.

If at any time you wish to revert to Focal*Point's default setup, simply remove all Delete and Transfer file
extensions and add the .* extension as the only transfer qualifier.
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File Archive Mode

Manual Receive File Administration

This feature works in conjunction with Focal*Point's Receive File Administrator (RFA). When enabled, Focal*Point
will automatically save (archive) original DNC*Library files whenever the file is targeted to be overwritten by a
new file from within the RFA. Focal*Point will archive the file in the following way. Before overwriting the
original file, Focal*Point will search for a directory named FPArchive on the target drive. If it does not exist,
Focal*Point will attempt to create the directory. Keep in mind that operating system and network privileges may
stop Focal*Point from creating this directory. In such a case it will be necessary for your network administrator to
manually create and administer read and write privileges for the FPArchive directory.

If the FPArchive directory exists, Focal*Point will create a sub-directory named in the same fashion as the original
file's directory and save the original file with a numerical sequence number attached to its name. For example, if the
original file name and its path are represented as F:\ncfiles\lathe\1234.nc, Focal*Point will save the file as
F:\FPArchive\ncfiles\lathe\1234(001).nc. Each time the 1234.nc file is archived the sequence number will increment
by one, i.e., 1234(002).nc, 1234(003).nc etc.

Note that all new file names will attach a sequence number that begins at (001), and source file directories will be
duplicated only one time within the FPArchive directory. This manner of archiving will allow for easy sorting,
review and retrieval of archived programs.

Of the two modes of archive depicted in the above graphic, selecting "Automatic" will force all overwritten files to
be archived. When the "Let User Choose" option is selected, a prompt will be displayed that allows the user to
decide file archiving on an individual basis.

UBypass Receive File Administration

Selecting this option will allow program archive for each machine that is set to "Bypass Receive File
Administration" in the Options section of the Communications parameters. This is useful for shops that allow
operators to refine programs, upload them, and save them as the accepted master program.

UAutomatic Library Transfer

This option will enable archiving when programmers use Automatic Library Transfer to add files to the
DNC*Library.
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Resource Types

Resource Types

Aside from the cataloging and transfer of NC programs, Focal*Point has the ability to link associated resource files
such as, Graphics, Photos, CAD Drawings and Process Sheets to individual machine operations. The "Resource
Type List" is built according to your company's requirements and in-house terminology. After developing this list,
Focal*Point's Part and Operations database can be populated with the above mentioned drawings and photos.

Note that in order to view these resources you must specify a Resource File Viewer as shown below. The viewer can
be any graphics program capable of displaying files in your resource list. However, for ease of operation CNC
Innovations offers a direct link to Cimmetry Systems' AutoVue** program. With AutoVue, you can view
documents from well over 150 file formats, including word processor files. For more information contact CNC
Innovations' Sales Dept. at 508-523-1763.

Also note that when specifying a third party viewer other than AutoVue, the software must be capable of accepting a
command line argument containing the name of the file to be viewed.

Specifies the location of a Resource File Viewer

In all cases, when specifying a graphics viewer, AutoVue included, use only the "Custom Graphics Option." The
AutoVue option will only work in conjunction with a NetHasp security key.

** AutoVue is a registered trademark of Cimmetry Systems, Inc.
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FTP Setup

Prior to using FTP for transferring machine programs, it is necessary to to specify a Root FTP folder. The Root
folder represents the highest level folder that an FTP client may navigate to during an FTP session. Use the Browse
button to select the desired folder. Keep in mind that all FTP folders should be located within sub-folders of this
location. Once the Root folder has been selected you can then select machines to use the FTP option from within the
Settings>Communications Parameters page. Enable the Verbose logging option to capture FTP commands when
troubleshooting an FTP connection. When activated Focal*Point will create an FTP.log file located in the
\cncinnov\fpdnc folder. Be sure to turn logging off when it is no longer needed

The Root Folder is the "highest" level in the folder "Tree" that you can navigate to. For example, to restrict FTP
navigation to "C:\FocalPointShare" and not allow the user to browse into the "C" root folder you can set the Root
Folder to "C:\FocalPointShare". Managed folders and Timer Folders restrict you to the specified folder anyhow so
you can just set the value to "C:"
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View Menu Items

Active FTP Connection viewer instantly reveals machine and IP addresses connected to Focal*Point's FTP server.

The server supports three connection types: Managed, Restricted and Full access. Managed access is similar to
RS232 machines regarding program upload and remote program requests. Queue only the currently approved
program and automatically save revisions to the Receive File Administrator.

The View menu provides access the Active FTP Connection form as well as the FTP.log. As shown above these
these features provide powerful tools for setup and monitoring FTP activity.
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TDNC Library SetupT

Numeric DNC ID Calculation Method

Among the numerous methods provided for creating or manually inputting a DNC Library ID tag when adding
entries in the DNC program library, there are two distinct methods for creating what is called the Next Numeric ID.
As this setting effects both the Library Entry form and Auto Library Transfer function, only one method can be
selected as the system default.

The option to reuse unassigned IDs will parse the DNC program library for unused numeric IDs and offer
suggestions based on available numbers. This is useful when library entries have been deleted and expect to be re-
assigned or when previous IDs exist in random order.

The second option will parse the library for the highest ID number and then increment by one. This method is useful
for compatibility with older versions of Focal*Point.

Note that this setting only affects the numeric ID creation and does not impact extracting a numeric ID from a file
name. It is also used as the basis for ID creation when using Auto Libaray Transfer with the option to use the next
available numeric ID.



34

NC Program Categories

One of the first steps when configuring Focal*Point is to enter the NC Program Category information. By linking
each machine to a specific program category, Focal*Point will have a powerful means to control file distribution,
sort window displays, and format printed reports.

Before entering categories, first determine the level of file sharing or restriction that you want to employ for each
machine in your network (Each machine will be assigned one of these categories). Entering highly specific
information for each station, such as "Work Center 1 Lathe," will restrict the operator’s remote requests to NC
programs tagged with that category. Likewise, a program category of "Lathe" will allow file sharing among all work
centers assigned to category "Lathe."

Keep in mind that both the machine communication parameters and the DNC*Library files must contain a NC
Program Category definition before this feature can take effect. To enter a NC Program Category simply click on the
"Add" button in the windowed display and enter the pre-determined category name. Since Mazak CMT files must
bypass the Receive File Administrator, the additional program directory is generally used only for Mazak controls.
The specified directory will be used to store new Mazak program files as received by Focal*Point. If a directory is
not entered then the default \FPDNC\NCFILES directory will be used.

If a program directory is entered for non-Mazak controls, that is, those that take advantage of the Receive File
Administrator, the file "Send" and "Receive" function will default to the associated directory.

Note that if an entry is deleted from NC Program Categories, Focal*Point will also remove all assignments of the
category in the DNC*Library and the Communication Parameters section.
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Settings Menu
Communication Parameters

Main Communications Setup Page

The main communications page provides for naming and classifying your CNC equipment, as well as the
communications method used by the machine control. Listed below is a description of each the parameters and
options available when building a robust and effective DNC system.
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Machine Name and Category

Connection/Machine
Each numbered and active machine connection can have a corresponding machine name. For easy identification, the
machine name is then displayed on Focal*Point's front page, machine grid. To change the displayed name, simply
place the cursor within the Machine label section and type the desired machine name. Please note that when exiting
the Communications setup page, it may be necessary to restart Focal*Point in order to refresh the machine display
grid.

Facility ID
The Facility ID is simply an identification label. It can be used for corporate identification and Advanced Data
Collection.

Program Category
A Program Category may be designated for each machine in order simplify program selections for transfer, to add
security to file transfers, sort display windows, and format printed reports. By identifying each machine connection
with a specific category, you can apply file transfer restrictions to your DNC network. In the above example, the
Mori Seiki machine is restricted to DNC Library files associated the Category of Mori Seiki. Program Categories
must be created before they can be applied to a specific machine. See - System Defaults > Program Categories

Basic Communications Mode

Focal*Point provides three main methods to facilitate NC program transfers to and from each machine control. They
are Serial, FTP and Timer Folders. One of these three methods must be selected prior to configuring the remaining
communications settings. It is only necessary to configure the settings directly associated with the selected
communications mode. The remaining settings may be left in their default state.

Serial

The most often used mode will be Serial. This represents the common RS232 mode for program transfers. It is most
often seen as a DB9 or DB25 connector located on the control panel or on third-party BTR devices. Most of this
help page describes the serial mode and its many options. See RS232 Functional Description listed below.

FTP

The FTP option stands for File Transfer Protocol. This method of transfer is seen on modern controls and utilizes the
Local Area Network (LAN) for program transfers. Since this method is inherently different from serial, it is
described within it own section. For more information see the section labeled FTP File Transfers
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Timer Folders

Timer Folders is a variation of the FTP file transfers method. This feature combines simplified machine Ethernet
connectivity with the long-standing ease of RS232 style remote program requests. Take advantage of network file
shares in combination with Focal*Point's Timer Folders for completely managed remote program requests. This
option works in combination with proprietary third-party, FTP servers by monitoring the server's transfer folder. By
using the Timer Folders option, Focal *Point has the ability to manage programs and remote file requests in much
the same manner as the Serial and FTP Managed folder options. For more information see the sections labeled
Timer Folders.

RS232 Functional Description

Specific Protocol

Specific Protocol is an option for the RS232 serial parameters only. It is a drop-down window that offers alternate
communication protocols used by certain manufacturers. The default General protocol is used for all standard
connections, while Mazak CMT is used for communicating directly with a Mazak CMT port. When communicating
with CMT be sure to use the main screen "Send" and "Receive" buttons to initiate file transfers or use a remote hand
terminal as supplied by CNC Innovations. When receiving a file from a Mazak control, be sure to name the file with
an MZP extension. By doing so, the software will recognize the program as "Mazak CMT" when displaying the
received file’s attributes. Additional protocols include Heidenhain Blockwise, Bridgeport DNC Link, GE2000,
Moog S-24, and Kearney & Trecker (K&T).

Baud Rate

The Baud Rate refers to the speed at which two RS232 serial devices are communicating. It is important that both
devices are set for the same speed before attempting any communication.

Comm Port

The Comm Port selector will assign an active communications port for the displayed machine connection. Active
Comm ports can either be resident serial ports (Com. 1 & 2) or add-on ports such RocketPort or DigiBoard
hardware. When using add-on ports, be sure to designate the first machine connection as Com 5 or higher. Add-on
ports should never start at Com. 1 since there would be an obvious conflict with the existing PC hardware.
Furthermore, each machine connection must have a dedicated port. That is, it must not be used by any other device
such as a modem or mouse. Refer to your Windows help documentation and the System Device Manager for details
about Com Ports available to your PC.

End of Block

End-of-Block conversion is a drop down window offering a list of line terminators that are used to match each
control's program block terminator. For example, if the control outputs line feed as its end-of-line character, select
Line Feed (10) as the End-of-Block. With this selection Focal*Point will automatically add a Carriage Return to
incoming data which will result in a useful and readable format in the program editor. On program output, the dual
End-of-Block will be converted to line feed only.
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E.O.B. Nulls

The E.O.B. (End of Block) Nulls parameter will generally be set to 0 (zero). It is supplied for compatibility with
Bridgeport 3 & 4 controls that may require an end-of-block delay. The E.O.B. value can be set between zero and
sixty-four (0-64). Generally, a value of 50 will act a good starting number, and, if necessary, the value can be
lowered in accordance with simple experimentation.

Data Type

Select the language Data Type to match each control's setup.
Most controls utilize ISO, a sub-set of the ASCII language.
Also included are EIA, 7-bit ASCII and Binary. The Binary
protocol is generally reserved for the transfer of Executive
programs, this is especially true when communicating with a
BTR interface.

Parity

Select None, Odd or Even parity to match the parity selected on the machine control. The data parity is
automatically selected and is an integral part of the ISO and EIA Data Types. In contrast to the control parity, the
parity bit common to most RS232 data streams (computer to computer) is appended to each data byte and is then
stripped off by the device's UART (port hardware). In both cases, the data parity is used as a simple error-checking
device

Handshake

Select Software (X-on/X-off) or Hardware (RTS/CTS), pins 4 and 5 of the Db25 connectors, for the communication
flow control used by each machine tool. During remote file requests the requested file is held in queue until the
receiving device asserts either of these two signals. For machine controls that do not assert these signals, refer to the
Send Standby Time-out option.

If your machine control reports a data overrun or buffer overflow alarm, it is probably the result of an incorrect
handshake or end-of-block line terminator. In some cases it may be the result of the Com. Port’s FIFO buffer. In the
latter case, refer to the instructions listed in the section entitled, Program Setup.

The third option, Xon, is for compatibility with Mazak CMT and controls that transmit a Xoff character after
receiving an MO2 or percent sign. This unique combination can manifest a problem of ignoring the next remote file
request. Due to the nature of this handshake, however, it can not be used for controls that are drip-feeding or those
that require flow control during the load procedure. Before using this option, first enable the "Strip Trailing End of
Blocks" option as described below. In most cases this will resolve the problem.

Data Bits

The Data Bit selection is automatically selected for both ISO and EIA data types. Select either 7 or 8 data bits for
ASCII and always use 8 for Binary transfer.

Stop Bits

The Stop Bit selection offers either 1 or 2 bits and is usually set according to the machine control's settings. In most
cases, if the sending device is set for 2 stop bits and the receiver is set for 1 bit, normal communication will result.
However, reversing this situation will almost always cause framing errors during the data transfer. For this reason, it
is best to confirm the stop bit selection for both devices, especially when errors occur in one direction only.
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Remote Request Tab

Configures the operation of remote file requests

NC Program Qualifier String

The Qualifier String (usually a short program identifier on the first line of the remote request program) acts to signal
the DNC software that the incoming data is a request for a specific program file. Users of CNC's Multi-Task
program will recognize that Focal*Point combines the previous Qualifier and Remote Number into one Qualifier
String. This change will not affect previous calling conventions. In rare cases, it is possible to leave this field empty,
and trigger a file request directly from the "Request Code" as described below.

Continuous Feed

The Continuous Feed variable, which may be used within a remote request file, allows you to designate a word or
combination of characters that cause the requested file to run from beginning to end in an endless loop. In the above
example, the word "LOOP" is designated as the trigger variable for running a file continuously. Keep in mind that
when looping through a file it is important that rewind/stop codes such as M30 are not used in the file. Finally, this
variable must be placed after the program request line as shown in the example below.

Request Code

The Request Code, usually the ASCII character "P," precedes the program file's DNC*ID number, which acts as
pointer to the file as referenced in the DNC*Library. Note that both the Request Code and Qualifier String can be
changed for each machine in accordance with the machine control's ability to output the default control codes

Redirect Code

Remote file requests can be performed for controls that do not have the ability to output a request file. By entering a
unique character as a redirect code, a remote request containing the code and a target port connection will
automatically have the requested file queued for the alternate machine. The only restrictions are that the code must
be on the line following the program request, and the requested file must be a member of the target machine’s
designated program category. See the example below for more information.
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Key Pad

The Key Pad parameter is only used when an Easytalk, RTE-1000, QTerm (QSI) or Burr-Brown terminal is added
to the system. By selecting the appropriate keypad, Focal*Point will recognize remote requests that are issued by
these devices. In the case of the QTerm Keypad, remote requests can be issued for alternate machine connections.
For example, a typical request on the QTerm Keypad would take the form of, IN*1234, where 1234 represents the
file’s DNC*ID. To redirect the file to a different machine simply add a Pound Sign (#) plus the machine connection
number. Therefore, IN*1234#17 would queue 1234 on port connection 17. Note this technique can also be used for
file uploads.

When using Easytalk on a remote computer terminal, be sure to set Focal*Point for a hardware handshake
(RTS/CTS) or use the Send Standby Timeout feature and set the Keypad entry to QSI. Also, the RTE-1000 BTR
will require a Request Code of "T" and a blank Program Qualifier String.

Enable Remote Printing

This feature specifies the printer used for printing associated Part and Operation resource files when a remote file
request is received. Note that only files that have been tagged for Remote Printing will be routed to the specified
printer. For more information about tagging resource files see Parts and Operation resource attachments.

File Not Found Message

Highlight this entry and click the "Edit Message" button to create a custom message for a failed remote request. This
message will be transmitted in place of the missing file and will serve as a warning to the operator that the request
cannot be honored.

Sample Remote Request

The following sample program assumes that the user is requesting the program 4532672.NC, which is in the
DNC*Library and has a DNC*ID # of 35.

Program Output From The Machine Control

O1111 - Qualifier String
P35 - Program Request (DNC*ID # 35 preceded by the request code 'P') **
LOOP - Continuous Feed Variable
#13 - Optional Redirection Code to Port 13
M30 - Program Stop
%

** The program may contain two consecutive request lines. Focal*Point will concatenate them into one
request. For example, P35 followed by P6789 will result in a request for P356789.

In the above example, Focal*Point will first verify the program as a file request by confirming the presence of the
Qualifier String. Next it will extract the DNC*ID number 35 and prepare its associated program for transfer on the
redirected port #13. The NC file will commence transfer when Focal*Point receives either a software or hardware
handshake, or after a specified Send Standby Timeout period as defined in the Defaults section. Furthermore, by the
inclusion of a continuous feed variable, the program will transmit (loop) continuously as though it is a program on
loop tape. For more information be sure to review the Remote Request Procedures in Focal*Point's help program.
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Options Tab

Advanced Setup Options

Advanced Options

The Options section of the Communication Parameters has the following features as described below.

UStrip Header on Incoming Data

As its title suggests, this option will strip program header information from incoming programs. That is, it will skip
all data up to the first end-of-line character.

UBypass Receive File Admin.

When this option is enabled for a machine connection, it allows incoming files from the designated machine to
bypass the Receive File Administrator and overwrite an existing program file. The rules for a successful bypass are
similar to those of the Auto Library Transfer function. That is, the incoming program must already contain the
DNCID comment line that identifies the original program and its location as specified in the DNC library. If the
incoming program does not contain a valid DNCID for the machine and its specified Program Category the new
program will be transferred directly to the Auto Library Transfer "Error" folder. For more information about using
this feature, see the section Automatic Library Transfer.

UUse Send Standby Time-out

This option is generally used in conjunction with remote program requests. As always, when an operator requests a
program it is placed in queue (Send Standby) until Focal*Point receives either an X-on or RTS start command from
the machine control. Since some older controls will not output these start commands an automated send method is
required. The Send Standby Time-out period is part of the system wide setup; it is accessed in the Settings>Defaults
control window. Therefore, if the time-out option is selected, Focal*Point will automatically transmit the queued file
after the specified time-out expires.

This is the sequence. The operator outputs the remote program request and immediately initiates the program load
sequence on the operator's panel. Focal*Point will interpret the program request, queue the program in Send
Standby, and after the specified timeout transmit the requested file. No other operator intervention is necessary.
Please note that the timeout period must be longer than the machine's file load timeout.
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UIgnore Incoming Data While Sending

Enable this setting for controls that echo received data while downloading programs. Controls that do so will
continually haunt Focal*Point as it attempts to process the incoming data. In its normal state, allowing incoming
data during a Send operation allows the software to re-process a remote request--a technique that is useful to
operators who are forced to free program memory in order to load the complete program. Enabling this option will
free Focal*Point from processing echoed data, but it also prevents mid stream remote requests.

UStrip Trailing End of Blocks

With this feature enabled Focal*Point will strip (compress) end-of-block characters from the end of a NC File. This
feature does not literally remove the characters from the master program; it simply prevents their transmission at the
end of the file transfer. This feature is useful for machine controls that stop a download after receiving an M30 or
percent sign, a situation that will cause Focal*Point to remain in Sending mode even though the control has finished
loading.

UHandle Framing or Parity Errors

This is a specialized option that will take advantage of controls that display error signals or alarms when receiving
data with a framing error. When this option is selected Focal*Point will trigger the controls alarm when Focal*Point
receives data with a framing or parity error. That is, if an operator uploads a file to Focal*Point and the file is
corrupted during the transfer, Focal*Point will in turn notify the operator by attempting to trigger the control’s
framing error alarm.

UUse Send Standby PurgeU

This feature clears the communications port if a queued program remains in Send Standby in excess of a specified
countdown period. When enabled, it will only allow programs to remain in Send Standby for the global timeout
period that is specified in the System Defaults\Miscellaneous tab. After which, the port will be cleared "without"
transmitting the program.

The purge feature is useful on systems that do NOT use the No-Wait Read option. It is most useful when operators
mistakenly output an Xon start signal before the program has been properly queued and subsequently output an
additional program request. In this situation, the operator is actually buffering the RS232 port from seeing the
control’s Xon start code. Use this option to forcefully clear the communications input buffer in preparation for a new
program request. With this option enabled the operator need only wait for the timeout period to expire and then
output the remote program request as if for the first time. It must also be remembered, however, that all remote
program requests must be completed within the purge period. A similar situation occurs if the system is configured
to use Received File Confirmation and the operator forgets to load the confirmation program. As such, the next
program request will not be properly queued. Using the purge option solves both of these problems.

As a final note, Focal*Point's No-Wait Read option is not subject to the above described input buffering problem.
No-Wait Read was designed to eliminate the prerequisite 10-second Xon input delay when requesting programs and
therefore circumvents the situation that causes operators to re-request programs. Be advised, however, that this
option is incompatible with some controls when the RTS/CTS handshake lines are connected between the PC
hardware and the control. In such cases it may prove helpful to simply jumper RTS/CTS on the control side.

UPurge If Sending and Inactive

This option is used to clear the RS232 communications buffers and Focal*Point’s I/O status screen. Many machine
controls terminate a program load using specific characters such as the percent sign or other specific codes. This can
have the effect of halting program transfers before reaching the computer’s recognized end-of-file marker. While
this situation will not harm program loads, it can be misleading if Focal*Point consistently displays an I/O status of
Sending after the NC program load is complete.

It is important to remember that this option must not be used in Drip-Feed applications since any halt in program
transfers that exceeds the specified timeout period will force the communication port to reset itself back to the
Receive Standby state. Under normal conditions the default timeout should be appropriate for most machines and
RS-232 hardware combinations. In rare cases, especially when using low-cost communications hardware, it may be
necessary to increase the timeout delay. This situation will be evident if the machine fails to load an entire program.
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Hint - This option is especially useful when using the Send and Receive buttons located on Focal*Point’s main
screen because it will eliminate the need to reset the communications port manually.

UEnable No-Wait Read

No-Wait Read is a remote request option that will capture a machine control’s Load command (X-on character)
when operators fail to wait the prescribed wait time -- typically 10 to15 seconds – after punching a remote file
request. No-Wait Read provides the best and most reliable method for all standard machine operations. Using No-
Wait Read also eliminates the need to use Send Standby Purge when the Receive File Confirmation feature is
activated. Please note, however, that No-Wait Read may not work with all controls and should be tested accordingly.

Compression Options

Compression options will compress (not transmit) comments, spaces, line numbers, tabs and specific character
values. This feature is useful to conserve control memory while maintaining easy readability in program code.

Strip Header on Outgoing Data

When this option is selected Focal*Point will strip all information, i.e., code, comments, man readables etc., up to
the first end-of-block or the first of six specified characters listed in the "Outgoing Header String" variables.

Start/End Values

Start & End Constant

The Start and End character constant allows the transfer of specific leader and trailer codes for all program files. For
example, suppose your control requires 20 NULLS at the beginning of the program file--this represents the leader
portion of a punched tape--you would simply enter the ASCII value of "0" with an occurrence of 20. If your control
requires the "SPACE" code you would enter the ASCII value of "32".
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Start & End Strings

The ability to include Start and End Strings during program transfer gives Focal*Point the power to communicate
with third party BTRs or tape punches. For example, to include punch control codes, enter the decimal number '18',
punch-on, in the Start String and '20', punch-off, in the End String.

All program transfers will begin with the Start character followed by the Start String and end with End String
followed by the End character.

Received File Confirmation

Note that this feature is not available when requesting from a QSI or Burr Brown keypad

RECeive Confirmation is a feature that, if enabled, will provide the machine operator with a confirmation message
when programs are uploaded to the DNC system. The confirmation message will contain the first and last 5 lines—
excluding the percent sign--of the received program plus a line indicating the number of bytes received. These lines
will appear as comments between the Header and Footer sections, which should be coded to conform to the
machine’s standard program structure.

Upon receipt of an uploaded program, Focal Point will place the formatted confirmation message in Send Standby
and await the operators input command or begin transfer after an elapsed Send Standby Timeout period. In
circumstances where the operator is likely to forget to input the queued receive message, Focal Point can be
configured to terminate the transfer and clear the communications port after a Send Standby Purge time limit has
elapsed (See above). Also, see the Settings|Defaults menu for information about the Send Standby Timeout and
Send Standby Purge settings.
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A typical confirmation message will have the following form.

% --- Beginning of header
O2222 --- Fixed program number
(RECEIVED PROGRAM FROM MACHINE) --- End of header section
(First extracted program line) --- Start of extracted program lines

.
(Fifth extracted program line) --- End of first five extracted program lines
--- Blank formatting line
(TOTAL BYTES BYTES RECEIVED NNNN) --- Information tag
--- Blank formatting line
(Beginning of last five extracted lines) --- These lines are taken from the end of the received program

.
(Last line of the received program) --- This will be the last program line excluding the % character
M30 --- Start of footer section
% --- End of footer

It is important to note that it is the duty of the operator to download the confirmation message if Send Standby Purge
is not activated. If the operator fails to download the message, no additional incoming files or file requests will be
honored. Furthermore, because a fixed program number may be written into the body of the header, it is also
important for operators to delete the previous message prior to inputting the confirmation message. Failure to do so
will likely cause a duplicate program error at the control and terminate loading of the confirmation message. In such
a case the operator will need to upload his program a second time and follow the correct procedures.

Lastly, keep in mind that electrical noise may be considered a received program and thus trigger a Received File
Confirmation message. In such a case it would not be wise to leave noise generated messages in Send Standby as
this would inhibit normal communications. Therefore, it is highly recommended to enable Send Standby Purge
(described in the Options menu) whenever Receive Confirmation is enabled.
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Data Collection Overview

Data Collection Configuration Menu

Data Collection is an optional feature that is purchased separately. A 10-Day trial is available by activating the
option in Focal*Point's help "Mange License" section. After activating the 10-Day trial you will have the option to
activate Data Collection on any single machine connection. During the trial period if you wish to test a different
machine connection, first uncheck the "Extract Data From Incoming Stream" check box and then activate the option
on the new machine connection.

Information about this section is contained in the section titled Data Collection

Function Buttons

Print Parameters

The "Print" button is useful for printing each machine connection’s setup information. This is highly recommended
in the event of computer failure.

Save and Cancel

The "Save" and "Cancel" buttons perform exactly as indicated. Save will save the current setup and "Cancel" will
quit without saving.

Reset

Click the "Reset" button to activate new or changed communications parameters.

Terminal

Use the "Terminal" button to display a terminal emulation screen. This feature can be used as a troubleshooting tool
when configuring each connection’s communication settings. Upon entering the Terminal function, the background
DNC features will be disabled. Therefore, it is important to manually reset the main screen's port activity button
after exiting the Terminal function.
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Settings Menu
Custom Form Labels

Label Modification Window

With custom form labels, you can change many of Focal*Point's menu and window labels. For instance, you may
prefer to name the Parts and Operations selection to Master File Log. The convenience of renaming field items can
be helpful to companies that have a long established naming convention.

To change a field name simply highlight the item in the default labels section then edit the name as displayed in the
input screen. To accept the change, click the "Update Custom List" button. The custom field names will be
displayed when the "Use Custom Labels" selector is checked; remove the check to revert to the original names.

Since Focal*Point's help program will not reflect edited field names, it is highly recommended that all system users
fully understand Focal*Point's basic operation before changing any field labels.

Note that the custom label information is stored in the FPLocal.mdb database. Be sure to make a back up of this file
whenever changes are made. For more information regarding which files to include in a back up, see the section
regarding Emergency Backup and Activation Procedures.
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Settings Menu
Multi-User Administration

Multi-User Administration

Multi-User Administration allows several DNC workstations to share a single NC program database known as
Focal*Point's DNC Library. Most often the shared database will be located in a dedicated folder on a shared
network drive allowing access by DNC host computers and NC programmer workstations. An added advantage of
designating a network drive is that the DNC database and uploaded machine files will be readily available for daily
backup procedures.

For proper administration and identification of each workstation, it is necessary for each Focal*Point DNC host PC
as well as Administrative workstations to create a unique identity within the shared environment. IT personnel
should note that the shared folder will require full read/write permissions for each workstation or user login. To
allow for proper management of multiple users in the shared environment, Focal*Point also allows rebuilt
workstations to use an existing entry in the shared environment. This option is necessary in order to avoid
duplication of workstation entries when a PC is rebuilt or replaced.
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BELOW IS DESCRIPTION OF EACH COMPONENT OF THE MULTI-USER SETUP FORM.

Enable LAN Connection

The first step is to enable LAN connectivity by checking the option box. This will allow you to browse for and
select a desired folder on your local network. By doing this Focal*Point will use a shared FPShare.mdb (DNC
Library) database. If the database already exists it will not be overwritten. The new workstation will simply transfer
operations to the shared database location.

Note - For single-user stations (only one DNC host), a LAN connection may still be desirable. Since most networks
are backed-up on a regular basis, the DNC*Library database (Fpshare.mdb), as well as uploaded NC programs, will
be available for backup. Keep in mind that the individual machine communication parameters are configured during
installation and can be backed-up by copying the file FPLocal.mdb from the cncinnov\fpdnc\init folder to a secure
network folder. Of course, whether or not a LAN connection is established, it is always a good idea to back-up the
database files that are found in the .cncinnov\fpdnc\init folder.

Shared Files Directory

The next step is to browse to and select the location for the shared DNC database. The shared folder does not specify
where the actual NC programs reside, it refers only to the location of the FPshare.mdb database. Actual NC
programs can be located anywhere on the network. The DNC Library simply acts as a pointer to the location of NC
programs. It does not store or make a duplicate of the NC programs.

Cell Name

You will next click the button to create a new cell name or select an existing cell name. Creating a New cell name
is necessary for first time users that have not already joined the multi-user environment. The option to select an
Existing cell name is for workstations that have been rebuilt or replaced and must associate with the existing
identity. Take note that when multiple Focal*Point seats are attached in a multi-user configuration, each seat must
have a unique Cell Name. No two seats can share the same identity at the same time. If a workstation should crash
unexpectedly it remains logged-in within the multi-user environment. In such a case the next time the workstation
re-starts Focal*Point, it will first check the log-in status to see if another workstation has taken control of the
existing identity. If true, it will be necessary for the workstation to create a new identity.
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In the above screen example, if the workstation as already joined the multi-user environment, the current Cell
information will be displayed in the section entitled Current Cell Information. In most cases, as when first joining or
re-joining the multi-user environment, the user will either enter a new unique cell name followed by clicking the
button to Create a New Cell, or they may select to Re-Assign an existing entry for use by the workstation. Please
note that you cannot Re-Assign a cell name if it is currently in use.

Re-Naming the Cell Name

If necessary it is possible to re-name the workstation's cell name
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ALT Administrator

When Automatic Library Transfer (ALT) is enabled in the Defaults section of Focal*Point, it is also necessary to
designate one workstation to process the ALT functions. Since only one workstation can be assigned this function, it
is best to use a workstation that remains active during the better part of the day. If a workstation as already been
assigned this function, the check box will be grayed out. For more information see the section related to Auto
Library Transfer located in the Defaults section of the Setting menu.

Saving Selections and Unlocking a Locked Database

If a new computer workstation is replacing a computer that previously ran an old version Focal*Point, and the cell
name will be transferred to the new host, use the Delete function to delete the existing Cell name and station ID
before assigning the name to the new computer.

To save selections you must click the Save button or click Cancel to quit. Please note that when creating or re-
assigning a cell name Focal*Point will prompt you that it will automatically close and will need to be re-started in
order for changes to take effect.

The Unlock DB button is used in rare occasions when the database reports that it is currently in use by another user
and prevents access to certain operations. Keep in mind that some DNC Library functions require a locked database
to prevent manipulation by other users. If, however, a workstation accidentally shuts-down before properly exiting
Focal*Point, it is possible for the database to remain locked. In such a case, clicking the Unlock DB will resolve the
problem. Before clicking the UnLock button it is best to verify that no users are currently involved with extensive
library additions or deletions.
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Security Options

Security Window

Security Overview

Upon installation, Focal*Point defaults to the supervisor security level. As such, the first order of business should be
to input the supervisor password plus any additional system administrators. After entering the password, the security
options menu will only be enabled when the supervisor is logged on as the user. What this means is, "Do Not
Forget The Password."

The only way to restore access if the password is lost is to reload the program from the installation disks. However,
doing so will destroy all previous entries. Equally dangerous to forgetting the password is not setting one at all. In
such a situation, you run the risk that someone could accidentally enter a password and thereby exclude the
supervisor from accessing the security options.

If Focal*Point is shutdown and then restarted it will prompt for the last user's password before allowing access to
protected functions.
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Should a user attempt to execute an option, which he or she is not authorized for, a message will prompt them for an
override password. The override is a one-time exception that is invoked when the supervisor or a qualified user
enters his or her security code. For example, suppose that John (user 1) attempts to edit a program. Being a new
employee, he was not given clearance to perform that operation. If Steve (user 2) enters his password, John will
have access to the file editor for that session only.

Another feature of the security module is called the Guest option. It is permanently configured as a minimum access
user level--without password protection--that allows a password protected user to switch to a generic setup when he
or she leaves the DNC workstation.

Security Window Items

Users List

The Users List displays the name of each individual entered as a system operator. By
highlighting a user name, his or her security rights will be displayed. Of course,
setting user rights is only available to the system supervisor.

User Rights

User Rights are separated into the following categories: All, which includes everything except for Supervisor
options; System Settings, which include Defaults, Communication Parameters and NC Program Categories; File
Editing, and DNC Send and Receive (manual) file transfers. Also included is a section for the view and modification
of the DNC*Library as well as the Parts and Operations database and the Receive File Administrator. There is also a
section that permits the purging of Send File History and a section dealing with the management of LAN (Multi-
User Administration) resources of Focal*Point.

Of particular interest is the File Editor View And Print Only permission. When enabled, users are not permitted to
edit NC files when accessed via the DNC Library, Parts and Operations database, Receive File Administrator or by
opening the editor directly as listed in the main screen’s File menu. Note that the File Editing permission takes
precedence over this option and should not be used when the View and Print option is selected. This option allows
users to view and print NC files using either of the two supplied Gforce editors. Also note that this option will not
work if a third party editor is in use.

The administration of these security options can only be done by the system supervisor. For general operation, a
separate Guest user is supplied; it does not require a system password. This generalized user setting provides
minimal functionality without having to memorize an additional password.

User Information

When a user is assigned a password in the Modify User dialog box, which is listed below, the User Information box
will be filled. Make note, however, that passwords are never openly displayed, either to users or supervisors of the
system.
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Security Option Buttons

Add User
Selecting this button will allow the system supervisor to add people to the user database.

Modify Users
After entering new users, click the "Modify User" button to select specific user rights and a password.

Delete User
The "Delete User" button is used to remove names from the User List.

Return Button
The “Return” button will save all changes and return the user to the main program screen.

Changing Users

The Change User dialog window is used to change the current user
logged into the DNC workstation. The entered information must match
existing values in the Supervisor Option window. If a user has not been
assigned a password, it will not be required when making the change.

A Guest option is provided to allow any user to switch to a standard
configuration. The Guest option cannot be modified and does not have
security rights. (See below for a temporary override.)

Password Override

If the current user does not have clearance for a
requested function, a temporary override can be
issued by inputting the name and password of a user
who does have clearance. This is one time exception
and does not alter security clearance for other
functions.
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DNC*Library

Main Entry Screen

The DNC*Library is used to build the main NC file database. The library is essentially an address book and contains
the name and location of the NC programs that will be accessible to your machine controls. The remaining
(optional) fields display information about program descriptions, revision levels, file date and NC Program
Category. Included in the library is an automatically assigned DNC*ID number, which is usually derived from the
file name. It is with this ID number that a machine operator can issue a simplified remote file request without the
need for an extensive and cumbersome path statement. Significantly, this method also removes the restrictions
imposed by systems that use hard-coded file directories.

The Library has two display options, both of which are selected from the main menu bar. Click the "Show All"
option to view all library entries, or use the adjacent pull-down box to select only files associated with a given NC
Program Category (machine). When entering the DNC*Library from Focal*Point’s main screen, first highlight the
desired machine name and then click the DNC*Library button. This procedure will automatically filter the library to
show only files for that particular machine. If the "Show All" option is selected, all library files will be displayed,
and it will remain the preferred view for subsequent library operations.

Building the DNC*Library is a simple point-and-click procedure, and takes only moments to accomplish.
Additionally, after importing your NC programs into the library, they can be attached as specific operations in
Focal*Point's "Parts and Operations" database. These files, along with additional--and viewable--drawings and
documents, allow you to create what is essentially a "Master Catalog" of your manufacturing process.

The following three-step process will help you create your own "Master Catalog."

1. Import your NC program files into the DNC*Library.
2. At your leisure, document your part numbers in the Parts database.
3. Finally, attach all related documents for each part and its subsequent operations.
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Library Items

Sort Display (Up/Down Arrow)

For easier viewing, Focal*Point will sort library entries in ascending and descending order. To sort by a field
column, simply click on the field's heading and then click the appropriate Sort Icon.

Search Icon (Binoculars)

To search for specific items such as descriptions, NC files, DNC*IDs, etc., highlight the desired data field by
clicking on its field name and then click the "Search" icon. After initiating a search the Find/Search dialog box can
be closed and a "Find Next" button will appear on the main screen display. Click the "Find Next" button to advance
forward in the search. Keep in mind that the initial search process begins from the current grid location and moves
forward from that point. Additionally the Find Next button allows you to click Library items to view item details or
even to open the marked file in your chosen file editor. The "Find Next" feature will remain in effect until no more
items are found, a new search is initiated, or the library is closed.

Resize Field

By simply positioning the mouse cursor over a field's divider, click and hold the left mouse button to move and re-
position the field width divider.

Selection Bar

Some of Focal*Point's operations require the selection of single or multiple database records. For instance, you may
select several DNC*Library files for printed reports, yet a single file would be highlighted for use with the Send
function. To select a record, click the Selection Bar tab to the left of the record. To select multiple records, hold the
CTRL key while clicking each record selection bar.

DNC*ID

The DNC*ID number is used for remote file requests and is automatically assigned as the library is built. To change
the ID number simply click on the field and type the new ID. Only unique numbers UwithinU a NC Program Category
are allowed. As entries are deleted the DNC*ID can be re-assigned to new programs, but only after Focal*Point’s
DB Optimizer has been used.

The ID field can be manually edited to include alpha characters, i.e., an ID number of 3456 can be edited as
Job3456. Do not, however, add alpha characters to any file that will be requested by CNC’s RTE-1000 BTR. For a
detailed discussion refer to the Import Directory feature of the DNC*Library.

Hint – Double-click the DNC*ID to open the associated NC file within Focal*Point's designated NC editor.

File Name

NC program files are added to the DNC*Library by clicking the "Add Entry" button on the main screen. To change
the assigned NC file for a library record, simply double-click the file name field and select a new NC program from
the file dialog box. Clicking any other portion of the record field will open the assigned NC file in the program
editor.

Hint -- Double-click the file name to open the Library Detail view which provides a handy reference for additional
program information
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File Date

The "File Date" display reflects the NC file's date stamp when the file was added to the DNC*Library. This entry is
also updated when the associated NC file is overwritten via the Received File Administrator and when performing
library verification as described below. This is not a modifiable field as it is intended to represent the file's actual
date stamp. If the file is modified by a program other than Focal*Point, the date stamp will not automatically update.

Hint -- Double--click the file date to update a mis-matched, out-of-date, reference to the associated NC program. If
the file dates match then the usual Library Detail form will be displayed.

NC Program Category

This field displays the NC Program Category for the file. Keep in mind, that categories are first created during the
initial setup of Focal*Point. Once created, the categories are used during the file import module of the
DNC*Library. Using categories in this manner will assign files to specific machine controls, control display options,
act as a filter for reports, and add a level of security to remote file requests.

Description Field

This field in the DNC*Library is a general description of the NC program file. Click within the field to enter a file
description. If you are upgrading from CNC’s earlier Easytalk program, the file description field will be populated
with data from Easytalk’s 32-character part name.

Library Function Buttons

Add Library Entry Screen
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Clicking the "Add Entry" button will open the above Add Library Entry screen. This form will likely be the most
often used tool for adding individual NC programs to the DNC program library. (Note that the same method and
options are provided when saving files from within the Received File Administrator.) To begin, simply click the File
Browse icon to select any existing NC program located on your computer or on a LAN drive. When selecting files,
make certain that the file location will be accessible to all potential, PC authenticated, Users. This is important since
Focal*Point operates according to the inherited permissions of the currently logged-in user. If the intended User
(machine operator) does not have sufficient Read/Write access, then neither will Focal*Point.

After selecting a program, a DNC ID will be displayed based on the "last used" selection type. That is to say, the
default DNC ID field will display an ID based upon the previously selected method. If a new preferred method is
selected it will become the default selection for the next Add Library function. Please note that when using the
"Assign Next Numeric ID" option is selected, the rules for generating the numeric option are specified in the
Settings > DNC Library Setup menu. In addition to the displayed options, the DNC ID can be directly modified by
manually typing and overwriting the displayed DNC ID field. Lastly, another useful method for generating IDs--
especially for newly uploaded programs--is the Extract Program Number method that copies the program number as
displayed in the file preview window.

The Import Directory function described below contains additional information regarding the ID creation options.

The file preview window, as you will see, displays the first 100 lines of the selected program. This is not only
convenient as a means of program verification, but it also serves as a method to Copy and Paste embedded program
comments for use in the library's Revision and Description data fields. Additionally, although direct editing of the
program is not allowed, you can, however, insert a DNC ID comment line into your program. By inserting the
comment line you enable a very important program identification function used by the Received File Administrator.

Finally, this form also provides an easy command button to navigate directly to the Import Directory (Folder)
function, which is used when adding multiple programs to the DNC Library--see below.

Remove Entry

Remove Library Entry Screen

Click the "Remove Entry" button to display the Remove Library Files dialog box. Selecting the first option,
"Remove File Entry," will remove the previously highlighted entry from the the DNC Library. Selecting the second
option, "NC Program Category," will remove all entries within an associated Category. Lastly, "Remove All Files"
will remove every entry in the DNC*Library.

It is important to understand that removing library entries does UNOTU delete the actual program file. It merely
removes it from the DNC*Library's database.
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Modify

Clicking the "Modify" button will open a full data entry screen that can be used for entering or modifying a
complete record.

Send
The "Send" button is used to immediately transfer a highlighted NC file to any active DNC port.

NC Viewer (Optional)

This button, if it has been assigned to an NC program verification or modeling software application within the
Defaults menu, will open the highlighted library entry within the application. The software application must accept
the library entry as a command line argument. For more information contact CNC Innovations at 508-523-1763.

To implement this feature you must specify the program path in the Settings>Defaults section of Focal*Point.

Close Button
The "Close" button will exit the DNC Library and return the user to the main program screen.

DNC*Library (File Menu Options- ALT F)

Edit

When a line item in the DNC*Library is highlighted, selecting "Edit" will
immediately load the associated NC program into the program file editor.

Import Directory

Use the Import Directory feature to add an entire folder and sub-folders
of NC programs into the DNC*Library. The import function can
automatically assign DNC*IDs, based several creation methods for each
imported NC program. All associated information such as, descriptions,
and program revisions can be entered at your leisure. Pease note that any
DNC*ID creation method that will result in duplicate IDs will be skipped.

(To record skipped files the User is provided the opportunity to create a log file.) The rules for DNC*IDs is simple.
For each Program Category every NC Program must have a unique DNC*ID, i.e., DNC*IDs can be duplicated as
long as they are associated with different categories.

Again, the Import Directory screen has two important features; it will import program and assign them to a
particular NC Program Category, and it will create a DNC*ID based on the selected creation method. To assign a
program category to the files, simply select the category from the available entries. This, of course, presumes that
the categories have been previously assigned in the Settings|NC Program Categories window located on the main
menu screen.

The create DNC*ID feature has several options, most of which are self-explanatory. Two methods of interest are the
Next Numeric and the Extract Number From Within File Name options. The function of the Assign Next Numeric
ID option is determined by the selection within the Settings > DNC Library Setup menu. Note that this setting
applies to individual seats of Focal*Point, which means that in a shared network each programmer can set this
option according to his or her own preference.
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Two creation methods are available for Assign Next Numeric ID. Reuse Available Unassigned Numeric IDs Within
Each Category, and Use One Plus the Highest Previously Assigned Numeric ID Regardless of Category. The first
selection parses the DNC library by Program Category and uses any open and available DNC ID number. This is
true even for library entries that have been deleted. The second option determines the highest numeric number
within the entire library and then adds one to create the next ID. Note that the highest number is saved in the shared
portion of Focal*Point to ensure that multiple programmers will always generate numbers based on the last highest
number used.

The Extract Number From Within File Name extracts an ID "Number Only" from any contiguous number pattern,
reading from right to left and starting from the first "dot" file extension or name separator.

For Example:

File Name Extracted ID

1234AB.56 1234

AB1234.NC 1234

NC2345A.67N 2345

Finally, the Extract File Name (with or without extension) extracts the first twenty-five characters, reading from right
to left and starting from the first 'dot' file extension or name separator.

For Example:

File Name Extracted DNC ID

1234job.56 1234job (without extension)

NC2345job.67 NC2345job.67 (with extension)

Insert Comments with DNC*ID

When you click this option in the DNC*Library, you will enable an important feature for the Receive File
Administrator (RFA). Ordinarily files that are received will be compared to their original program by highlighting
target files in the RFA's "Last Sent" list. This process of program identification can be slow and cumbersome if the
Last Sent list has several programs listed.

Fortunately Focal*Point offers an easier way. The Insert DNC*ID option will place the DNC*ID string as the first
or second comment field within every NC program file. As such, when a program is received in the RFA, the
imbedded DNC*ID will be used as an index for directly matching to the original program in the DNC*Library. This
feature eliminates the need to match files against the Last Sent list in the RFA.

This simple comment will take the form of (DNCID52346) for a DNC*ID of 52346. Note that, if necessary, these
comment lines are easily removed by an additional feature within the DNC*Library menu. For machines that will
not accept comments, you can simply enable the "Strip Comments" option located within Focal*Point’s
communications parameters or alternatively Insert IDs based on a pre-selected Machine Category as displayed at the
top of the DNC *Library screen. .

Procedural Notes

Before using this feature, keep in mind that some programmers may put comments on the same line as the program
number. In that situation Focal*Point may put a comment prior to the first program line which will cause some
controls such as Fanucs to refuse to load the program. In this case it is advisable to use the "Insert DNC*ID as the
Second Comment" option.

Furthermore, do not forget that this feature will automatically write the comment in every NC program. The
procedure can not only be time consuming, but it may also change the file's original creation date/ time stamp. If you
do not wish to change the file’s date stamp, be sure to indicate your choice before executing the function.



61

Lastly, Focal*Point offers this feature for the entire DNC*Library or for a pre-selected Program Category. It is only
the Add Library Entry form that allows updating single file entries. For this reason it is easiest to perform the "Insert
DNC*ID" function after building the bulk of the DNC*Library. After which, all new entries can be modified with
the Add Library Entry screen. It is important to note, that if library entries are performed using Automatic Library
Transfer, it is possible to rerun the "Insert DNC*ID" function a second time. This action will not create a second
comment line; it will only add the comment to files without an existing "ID" comment line. In this particular case it
is usually best to insert the comment only for the intended machine category.

Remove DNC*ID Comments

As its name implies, this function will remove previously inserted DNC*ID comment lines.

Verify Library Entries

Use the Verify Library function to authenticate the existence of each program in the DNC*Library. This function is
useful to re-establish the path and location for orphaned files and for regular maintenance of the library when
programs have been deleted from their storage location. Files are displayed in a pop-up window with a browse
feature to locate missing files, and a delete key for removing the library entry. This function will also update the NC
file's date stamp as displayed in the library. Another important feature is the ability to change the drive designation
for the orphaned program files. This is useful when the entire DNC system is migrated to different servers and
mapped drives. To make the process simple you need only copy the program files to their new drive and make
certain to duplicate the original path.

Print Library & Selections

The Print Library feature will print a report of the files in the DNC*Library to the default printer. To print only
certain selections, select the records by holding down the CTRL key while clicking the record selection field on the
left side of the display.

To print by NC Program Category, click the appropriate selection and indicate the desired category.

Convert End-of-Block (UNIX to DOS)

The convert EOB function is provided for file compatibility with UNIX based workstations that do not have the
ability to save files in using the DOS end-of-line format (Cr/Lf). By selecting this feature, Focal*Point will
systematically open the selected files and convert all line feed characters to carriage return and line feed. Note that
this is a permanent file modification and will modify the file’s time and date stamp.

Replace DNC ID's with Description Data

This unique feature provides backward compatibility with CNC's Multi-Task customers who are accustomed to
issuing remote file requests based on Multi-Task's 32-character part name. When a customer upgrades from Multi-
Task to Focal*Point, their 32 character part names can be automatically added to the DNC*Library's description
field. By selecting this feature, Focal*Point will extract the first twenty-five characters of the description field and
replace the DNC*ID with the resulting data. Focal*Point will not, however, create duplicate ID strings during the
conversion process; rather, it will skip entries that would create such a conflict.
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Parts Database

Aside from the DNC*Library database, the Parts and Operations module could become your main organizational
tool. Once you have setup the System Defaults and NC Program Categories, and have imported NC files into the
DNC*Library, the next step is to build the Parts and Operations database. Focal*Point allows you to record part and
operation numbers as the basis for streamlining your manufacturing process. It this manner your NC files and related
drawings, photos, and setup information are all readily available at the touch of a button.

For example, the Acme Tractor Clutches Company contracts you to build their part number 53, which involves five
NC operations. First, you would enter the customer’s name, description, part number, and revision level. At this
point, you may wish to attach notes and resource documents to the part number. By attaching "resources," such as
CAD drawings, graphics, pictures, or
text documents, the information can be
easily viewed at any point in the manufacturing process. Once the basic information is compiled, click the
"Operations" button to record the five operations required in the manufacture of the finished part. Again, for each
Operation entered, you can attach any number of resource documents.

After completing the above operations, you will have achieved a completely paperless manufacturing process. But
Focal*Point does not stop there. You will also have the tools to verify and track revision levels, maintain a catalog
of old revisions, restrict program edits and distribution, track program transfers, and lastly, with aid of two program
add-ons, you can test the integrity of program code and provide red lining options for program drawings.

Functional Description

As in the case of the DNC*Library, the Parts database also has two display options, "Show All" and "View by NC
Program Category." Click the "Show All" option to view all Parts entries, or use the adjacent pull-down box to
select only files associated with a given NC Program Category (machine). When opening the Parts database from
Focal*Point’s main screen, first highlight a machine control and then click the "Parts & Ops" button. Using this
procedure will automatically filter the database to display parts for the selected machine.

For convenience, a special feature in Focal*Point allows you to rename many of the Parts and Operations field
labels in order to conform with existing company terminology. For more information refer to Customize Field
Labels within the Settings menu.

*NC Verify is a trademark of Sirius Systems Corporation.
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Note that the above methodology depicts the recommended procedure for building the Parts and Operations database.
For those who are in a hurry, however, or if you are upgrading from a previous Multi-Task version, Focal*Point allows
you to start DNC transfer operations as soon as you have imported NC files into the DNC*Library.

Parts and Operations Described

Sort Icon (Up/Down Arrow)

For easier viewing, Focal*Point will sort entries in ascending and descending order. To sort by a field column,
simply click on the field's heading and then click the appropriate Sort Icon.

Search Icon (Binoculars)

To search for specific items such as graphics or part numbers, highlight the desired data field by clicking on its field
name and then click the Search icon.

Part Information

The Parts database maintains information about each entered Part Number. This includes a part revision, and any
associated resource files. After entering your customer's part numbers, you will have the basis for all subsequent
machine operations. To add new parts click the "Add Part" button at the bottom of the screen. To select a particular
part, click the arrow in the Part Number field. This will display a drop-down box containing all relevant part
numbers. To help locate a part quickly, you may type the first character of the part name, which will automatically
scroll the selection window. Otherwise, you may click the search binocular icon to locate a desired part.

Customer Field

This field allows you to reference a customer name for each entry in the parts database

Description Field

You may enter a description for each part. This will help you to easily identify a particular job or product.

Part Resources

Part Resources is a list of attached documents relating to each Part. Within the Resource Actions display screen you
can Add, Change, Remove and View resource attachments. Within the resource grid you will find a label depicting
the Resource Type--which is defined within the Defaults menu—plus the location and name of the resource file, and
finally, an optional print number and revision date for the file.
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Note - Before viewing a resource file you must designate a resource viewing program as specified in Focal*Point's
Setting|Defaults menu. Although any graphics viewer can be specified, CNC Innovations recommends the program
AutoVue by Cimmetry Systems, Inc. With AutoVue you can view well over 180 different file formats including
text and CAD documents. For more information, or to purchase AutoVue, contact CNC Innovations’ Sales Dept. at
508-523-1763.

Menu Items

Print Parts (File Menu)

The Print Parts option will print a listing of all the part numbers that have been entered in the parts database.

Close
The "Close" button will exit and return to the Main menu screen.

Part Function Buttons

Add Part Button

Click the "Add Part" button to add entries to the parts database. Afterwards you can attach machine operations by
clicking the "Operations" Button.

Rename Part

Use the "Rename Part" button to modify obsolete or existing entries.

Operations Button

By clicking the "Operations" button, the Operations Entry screen will be displayed. In this module you add all of the
manufacturing steps (operations) needed to produce a finished part. Keep in mind that the Operations window will
only display the operations associated with the previously selected part number, and each operation may be
associated with any number of file resource attachments.

Notes Button

By clicking on the "Note" button, you can add manufacturing notes, dates, reminders and customer details to each
part in the Parts database.

Close

The "Close" button will exit the Parts display screen and return to the main menu.
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(Operations Sub-Window)

The Operations display screen is divided into two sections, Operation Actions and Resource Actions. Operation
Actions is the list of machining operations used to manufacture a part. Again, as in Parts, each operation can be
assigned any number of Resource Actions. By highlighting an operation and clicking the "Details" button, all
information for the operation will be displayed in one handy screen. If a DNC resource is highlighted, the "Send"
button will queue the selected file for immediate transfer to a selected machine control.

The Operations Resource screen is identical to the Parts resources except for the addition of the "Add DNC File"
button. Click this button to add a NC program to your list of resources. The DNC file has a special significance.
First, there can only be one DNC file for a particular operation. Second, as you can see above, only the DNC
Resource file has DNC*ID tag.

If you recall from the information about the DNC*Library, Focal*Point uses the DNC*ID, which is usually a
duplicate of the original file name, to identify NC programs for a particular operation. If you are not familiar with
the DNC*ID, refer to the DNC*Library section of the help program.

You may click the "View File" button after highlighting a Resource Action. If the action is a DNC file, the program
will be displayed in your selected editor program. If the resource file is a graphics file, it will be displayed within
your selected graphics-viewing program. For more information about editor and graphics viewer options, refer to
the Settings|Defaults menu.
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Resource Details

The above graphic depicts only a portion of the Resource Details screen. Of particular interest is the Remote
Printing check box. This option may be activated individually for each operation resource. When selected, it will
enable Focal*Point to automatically print the resource file to the printer specified in the remote request section of
the Communication Parameters. The automatic printing will be performed when an operator makes a remote request
for the DNC file listed in the operation’s "Resource Actions" group. In other words, if an operator requests the
above file with DNC*ID 5330, Focal*Point will print the Drawing P1200-5330 to the control’s specified printer.

Note that it is not only necessary to specify a target printer, but it is also important to activate remote printing within
the communication parameters of each machine. Furthermore, since remote printing is accomplished using the
AutoVue graphics viewer, it is necessary to run the demo version or purchase the AutoVue program. For more
information, contact CNC’s at 508-523-1763
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Receive File Administrator

The Receive File Administrator (RFA) acts as a sentinel that intercepts, directs, and categorizes incoming files for
easy viewing, comparison and file maintenance. As part of its operation it maintains a list of received files for each
machine connection in the DNC network and coordinates with the DNC*Library when programs are overwritten
with new revisions. For maintenance free service, an additional feature will allow selected controls to by-pass the
administrator and automatically overwrite existing NC files with their latest revision. Note that to enable this
feature, be sure to review Focal*Point's Auto Library Transfer function and the Advanced Options section of the
Communication Parameters.

The Received File Administrator has two basic view modes that affect the way received files are matched to their
parent file. These modes are labeled "Last Sent" and "NC Library," and are accessed by their respective buttons
located along the bottom portion of the RFA display screen.

In NC Library mode the right side of the display window represents actual DNC*Library files--filtered by NC
Program Category--while the left pane will show all received files for the selected Cell. In the above representation
the highlighted file was received on connection 2 and, therefore, matches its parent file having a program ID of
4745120. Note that in NC Library mode, Focal*Point will automatically find and highlight the parent DNC*Library
file so long as the DNC*ID comment line has been added to the file. For more information about adding the
comment line, see the section entitled "Insert Comment line w/DNC ID into Lib Programs" located in the File menu
of the DNC*Library.

Clicking the "Last Sent" button accesses the second file-matching mode of the RFA. Unlike the "NC Library" mode,
the "Last Sent" mode does not have automatic file matching capabilities; it simply displays the files that have been
transmitted to the machine control. This is a valuable display mode since it provides a method for matching revised
NC files to their parent file when the attached machine control is incapable of outputting comments lines containing
a DNC*ID tag.

The following information will detail the individual components of the RFA module.

Refresh Listing Button

An activity list for received files is maintained for each machine connection within each DNC cell. Clicking the
"Refresh Listing" button will immediately refresh the display's activity listing.
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Cell

The Cell selector—required in multiple seat configurations of Focal*Point--displays the name of each licensed seat
connected to the DNC system. To view received file activity for a particular DNC cell, simply highlight its name from
the selector's pull-down menu. To view activity specific to the local (current) DNC host, click the "Local Cell" button.

Auto Received File Section

Received Files Display

This area records and displays all incoming file activity. When files are uploaded from a machine control to the host
DNC system, each line will provide important file information; such as, the connection number the file was received
on, the machine name as it is listed in the communications section, the date and time the file was received, and
finally, the path and temporary file name given to the received file. The temporary file name is actually a
representation of the port connection and the receive order of the captured file. For example, mtre1.3 refers to the
first file received on connection three. If Multi-User Administration is enabled the received file will be stored in the
common LAN directory and have a naming convention similar to "1X6.2", which refers to sixth file received on port
two of DNC cell number one. To review files received on another DNC cell, simply make your selection using the
"Cell" selector as described above.

If the received file contains a DNC*ID comment line as described in the DNC*Library, the file will be automatically
matched to the original program as listed in the Library. This will facilitate easy file comparison when searching for
program revisions and when overwriting existing Library entries. Also, double-clicking an entry will immediately
open the file in the NC program editor.

In general, the majority of file maintenance will be performed within the RFA module. However, in the case of
Mazatrol CMT programs, which by-pass the RFA and cannot be edited, the received file will be stored in the
directory specified for the control's NC Program Category.

Delete File

The "Delete" button will delete the highlighted file in the RFA's receive file display. This operation will not delete
files that are listed in the DNC*Library; it only deletes the temporary program file held in the RFA's storage area.

New Lib File

The "New Lib File" button will save the highlighted received file as a new entry in the DNC*Library. A default
directory and file extension can be specified in the Defaults section of the Settings menu. After selecting a suitable
file name, the Add Library Entry form as described in the DNC Program Library section will be displayed. The Add
Library form is used to select an appropriate DNC ID, insert ID comments, as well as copy and paste operations for
the program Descriptions and Revision information.

Compare Library File

Clicking this button will compare the highlighted "Received" file with the highlighted "NC Library" file. Use this
feature to locate, display, and print all program revisions prior to overwriting an original program file.

Note that files can also be compared within the NC File Editor, which may be opened from the File menu on the
main display screen.
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Overwrite Library File

This option will use the information from the currently highlighted "Received" file and overwrite the information in
the currently highlighted "Library" file. Before selecting this option it is advisable to compare the two files and
verify all program changes before making them permanent.

Note that when a program is overwritten with new data, the original contents will be lost and the file's revision
number will be incremented. To archive the original program, see File Archiving in the Defaults menu.

Send

Click the "Send" button to redirect a received file to another communication port. This is a useful technique if you
want a quick method of sharing a machine operator's program. This will not save the highlighted file or make a
library entry. If you wish to save the program you should perform that step after the file transfer is complete.

File Viewer

These view windows--one for existing and one for received files--display the contents of a highlighted file. Click on
any received file or library file to update the viewer screen for that entry. This display enables you to quickly
identify "Sent" and "Received" files before comparing them for program revisions. Additionally, if the
DNC*Library's "Insert DNC*ID" option is enabled, any highlighted, received program will be matched
automatically to its original program file. When a program match is visually verified in the viewer screen, click the
"Compare" button to display a complete list of changes and revisions.

Note that although automatic file matching is the preferred method, program files can be manually matched by first
highlighting an entry in the Received File list and then sequentially selecting entries using the "NC Library" or "Last
Sent" display list.

File Display Mode

These buttons toggled the RFA’s file display mode. By clicking either the "NC Library" or the "Last Sent" button
the display will switch between the two file matching modes as previously explained.

NC Library Mode

When the display is set to NC Library mode the heading for the file list will contain the NC Category name assigned to
the selected communications port. This information is quite useful since the file list will be filtered to display only files
of the same category. In the above display, the list is filtered to display files for the category Fanuc 0/3/1011T. If the
auto-matching feature is enabled (by inserting the DNC*ID comment line in the NC file), clicking and highlighting
files in the Received File display will automatically display the original program as listed in the DNC*Library.
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Last Sent Display Mode

The "Last Sent" display mode will show files that were transferred from the DNC host to each machine control.
This activity list is updated by remote file requests and manual uploads. For convenience, purging records in "Last
Sent History" to within a particular date will regulate the number of entries displayed in the “Last Sent” list. Note
that the Last Sent History is located in the main screen’s "Database" menu.

Scroll Bar

Sliding the Scroll Bar beneath the "Last Sent" or "DNC*Library" list will display associated information about the
selected item.

Close

Close will exit the RFA and return to the main menu..
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Send File and Archive History

(View Menu)

The View menu contains a selection for reviewing Send File history and File Archive history. Both functions
contain a purge feature that should be used on regular basis in order to minimize the size of Focal*Point’s operating
database.

Fie Archive Log

File Archive Log Located in the Database Menu
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Automatic Library Transfer Overview

Description

The Automatic Library Transfer function provides a mechanism for moving files into Focal*Point’s DNC*Library
without directly using Focal*Point’s database modules. This function is designed primarily for users with
CAD/CAM systems running on UNIX workstations where running Focal*Point’s administration function is not
possible. The Automatic Library Transfer function is also the engine that drives the "Bypass Receive File
Administration" option for serial communications links with Focal*Point. To activate the feature you must select a
"transfer" and "error" directory in the Settings|Defaults section of Focal*Point and click the "Enable" button. Before
doing so, however, take care to select an empty transfer directory before clicking the "Enable" button.

Functional Overview

The Automatic Library Transfer function works by periodically (about once a minute) scanning the "Transfer
Directory" to look for new NC programs. Each new NC program is then automatically moved from the Transfer
Directory to a user defined target directory for that program, and then assigned an entry in the DNC*Library. The
target directory and assigned DNC*ID are determined by scanning the first few comment lines in each new NC
program. With this flexibility an operator or programmer can easily add new programs or overwrite existing entries
in the DNC*Library.

When an operator wishes to overwrite an existing file with its latest revision, he or she need only enable the "Bypass
Receive File Administrator" option in the communications section and add a DNC*ID and Program Category
comment line at the beginning of the NC file. To further simplify this procedure, the DNC*Library has a feature
that will automatically add the DNC*ID comment to every file in the library, thus eliminating the possibility of
using an unintended ID number.

Note: If NC Program Categories are not used as part of Focal*Point's setup, then the Program Category comment
line is not required. However, because Focal*Point will allow identical DNC*IDs when they are specified for
different NC Program Categories, it is important to use the category comment line when Focal*Point contains
entries in its NC Program Category section. This distinction will ensure that only the intended file is overwritten
when using the Bypass RFA feature.

NC FILE Format

For the Automatic File Transfer option to work, the NC programs must have the following comment lines at the
beginning of the program:

.

.
(DNCID dddddd NEW)
(FILENAME f:\ffffff\...)
(PROGCAT cccccc)
.
.
where

ddddddd= Any valid DNC*ID.
NEW = Optional indicator. If not specified, it is assumed that the NC program is a replacement

for an existing program.
f:\ffffff\... = Any valid file path and name for saving NC files.
cccccc = Any Program Category defined by the user during system set-up.

*Capitalized words such as PROGCAT and DNCID are field specifiers and are always required.*
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Logic

Focal*Point reads each new program and then moves the program and assigns a DNC*ID based on the following rules:

The system first checks the DNCID line. If the optional command NEW is used, the system will extract the path
and filename information from the FILENAME comment field, then save the file and create a new entry in the
DNC*Library. If the DNCID value (dddddd) is specified, the system uses that value for the DNC*ID in the library.
If the DNCID value is left blank, the system will generate a DNC*ID based on the next available number for that
Program Category.

Specifications for NEW programs must not be in conflict with either an existing DNC*ID or an existing file path
and name. If so, an error will be generated. (See error information below.)

If the optional command NEW is missing the system will REPLACE an existing program with the new or revised NC
program. When REPLACE is used, the FILENAME (f:/ffffff/...) need not be specified. If the FILENAME value is left
blank, the system will use the existing file name as listed in the DNC*Library for the specified DNC*ID.

When REPLACE (NEW not specified), the DNC*ID must already exist and the FILENAME, if specified, must
match the one already in the DNC*Library. If these conditions are not met, an error will be generated.

Error Processing

If an error occurs in the Automatic File Transfer the file will be moved from the Transfer Directory to an Error
Directory and no changes will be made in the DNC*Library.

Transaction File

Focal*Point will maintain a Transaction File that will have the name FPAFT.TXT and will reside in the Transfer
Directory specified by the user. For each NC Program processed in the Transfer Directory a new line will be written
to the Transaction File. Each line will contain the following information:

DATE TIME NEW? DNCID PROG. CAT. FILENAME STATUS

This file may be read at any time by the user but the file cannot be opened for modifications. To purge entries the
user may simply delete the file FPAFT.TXT. The Focal*Point system will then create a new one on the next
transaction.

Default Directories

The system default directories are

C:\CNCINNOV\FPDNC\AUTOLIB for new transactions.

C:\CNCINNOV\FPDNC\AUTOLIB\ERR for error transactions and the transaction files.

These directories may be changed to any drive and path that is visible to the Focal*Point system computer. Before
assigning the directories, make certain that they are EMPTY. In other words, due to the automatic processing
involved with these directories, it would not be wise to select the root of drive C: when enabling this feature.



74

Remote Request Procedures

Remote Request Programs allow a machine operator to retrieve a desired NC program from the DNC Host by
"punching" or "outputting" a small request program from their CNC machine. A typical Remote Request would be
as follows:

This sample program assumes that the operator is requesting the program 4532672.NC, which is in the
DNC*Library and has a DNC*ID # of 35.

O1111 - Qualifier String
P35 - Program Request (DNC*ID # 35 preceded by the request code ‘P’)
#13 - Optional Redirection Code to Port 13 – See Communication Parameters for more information
M30 - Program Stop
%

Since the DNC*ID number is assigned to its associated NC files when the program is imported into Focal*Point’s
DNC*Library, the above program request will extract the DNC*ID--in this case the number 35--and prepare the NC
program 453272.NC for DNC transfer.

Furthermore, Focal*Point’s communication parameters would have been configured to use the program "O1111" as
the remote request qualifier, and the letter "P" as the identifier or Request Code for the DNC*ID number.

Before initiating remote file requests, be sure to configure the Qualifier String and Request Code in Focal*Point’s
communication parameters. The Qualifier String must be configured to match the request that each machine
operator will use. The Request Code, usually the ASCII character ‘P’, will precede the program file's DNC*ID
number. Both the Qualifier String and Request Code can be changed for each machine port according to each
control's ability to output the default codes. For example, the Request Code could be specified as a ‘T’ rather than
‘P’ for those who are familiar with CNC’s earlier default code.

Multi-Task users will recognize that Focal*Point combines the previous Qualifier and Remote Request Number into
one Qualifier String. This change will not affect previous calling conventions.

If the Remote Request section has not been changed, the default settings will be ‘O1111’ for the qualifier string and
‘P’ for the request code. As such the above program, output from the machine control, would, by default, act as a
request for a NC file from Focal*Point’s DNC*Library.

In short, the Focal*Point DNC software will extract the DNC*ID number "35" and prepare its associated program
for DNC transfer. The NC file will commence serial transmission when Focal*Point receives a software or hardware
handshake or after a specified default time-out period. For more information be sure to review the Communication
Parameters section of Focal*Point’s help program.

To facilitate controls that may limit the DNC*ID parameter length by inserting a decimal point within long ID
numbers, Focal*Point will allow two consecutive program request lines. These two lines will be concatenated has
one program ID. For example, the following program will request a file ID of 123435 from the DNC*Library.

O1111 - Qualifier String
P1234 - First Request Line
P35 - Second Request Line
M30 - Program Stop

The above request program will act as a request for the file associated with DNC*ID 123435.
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QTerm Keypad

Remote Request Procedures

ULoading Programs from the DNC Host

 Set the switchbox to the "A" position and depress the "IN" button on the QTerm keypad.
 Enter the desired file's DNC*ID number after the "IN*" display prompt.
 Depress the "Enter" key and set the switch box to position B.
 The file will be queued at the DNC host and will await the control’s request to send.

UTo Upload a Program to the DNC Host

 Set the switchbox to the "A" position and depress the "OUT" button on the QTerm Keypad.
 Enter a program file name after the "OUT*" prompt then press the "Enter" key.
 Set the switchbox to position B and upload the file to the DNC host.
 Focal*Point will save the received file using the selected file name.

UUsing Port Redirection

The QTerm keypad can instruct Focal*Point to Send or Receive a file on any machine connection attached to the
active DNC host. To redirect activity to another port, simply include the pound sign (#) plus the number for the
machine’s port connection.

 "IN*1234" -- Normal request format.
 "IN*1234#17" -- Request using redirection to port 17.

URestoring QTerm Programming

The QTerm’s IN and OUT keys are programmed to work exclusively with Focal*Point software. If for some reason
the LCD panel does not display the usual screen prompts, it will be necessary to reload the original programming as
follows.

 While holding the CLR key, insert the power cord. The display should show the version number and the word
CONTRAST when the key is released.

 Using the CLR (select down) and ENTER (select up) keys, adjust the contrast for easy viewing. When finished
press the OUT key to advance to the next menu option.

 Using the CLR or ENTER key select a Baud rate of "9600" then press the OUT key.
 Now set the Data Format (DF) for "8N1" and press the OUT key until you exit from the menu.

At this point connect the QTerm’s 9 pin connector to a computer serial port and verify that the operating system is
running in MS-DOS mode.

 Run the program "Qsetup4.exe" that located on the supplied QSI utility disk.
 Follow the menu instructions for specifying a n active communications port with a non-multidrop configuration.
 Select the "Load QDATA..." option and enter the name of the default data file for the QTerm keypad. This file

is supplied by CNC Innovations and usually has a name that is derived from the customer’s name. This
completes the programming for the QTerm keypad.
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FTP File Transfers

Initial FTP Setup

Prior to using FTP for transferring machine programs, it is necessary to to specify a Root FTP folder. This represents
the highest level folder that an FTP client may navigate to during an FTP session. Setting the Root folder is done
within the Settings menu. See FTP Setup.
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Managed FTP

FTP Managed Folder Screen

The FTP Managed folder is for transient files only. The Managed folder works in conjunction with Focal*Point's
internal FTP server. When the specified machine client places a file in this folder, Focal*Point will check the file to
determine if it is a remote file request matching the parameters entered in the Remote Request tab as described
below. Once the file is determined to be a valid request program, a copy of the target program will be placed in the
Managed folder where the operator can then download (Get) the program. In the event that a Remote Request fails, a
file is created named "FILE ASSOCIATED WITH DNCID NOT FOUND" or "DNCID NOT FOUND".

If the incoming program is not a program request, it will be moved to the Received File Administrator. Also, when
the "Apply automatic EOB conversion" option is checked, Focal*Point will convert the incoming program's internal
End-Of-Block characters to Carriage Return and Line Feed (CR/LF). This provides for a normal display when
viewed with standard file editors. (Do not Use this option when receiving binary or executable files.) Also, to avoid
clutter in the managed folder, the "Purge Remote Request files" option will delete requested programs after the
specified time period. If left blank, the program will remain in the managed folder indefinitely.

When setting up Managed FTP it is best to designate individual managed folders for each machine. This folder must
be a sub-folder of the Root FTP folder. It is also best to provide each Machine/User a unique User Name and
Password for FTP login verification.
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Managed Folder Advanced Options

FTP Advanced Options for Managed Folders

To assist in easy transfer of program files from the FTP managed folder, the Advanced Options menu provides
windows file naming and internal program naming options. First and foremost is the ability to add the program
character "O" to the windows file name. This provides the most efficient transfer of programs from the managed
folder to data server equipped controls. Programs can then be loaded directly without the need to rename prior to
loading.

Another feature is the ability to truncate program names to a specific number of characters or to truncate program
names up to the first non-numeric character. Similar options are also available for naming the internal program
name/number. Be advised, however, that when renaming the internal program the specified character whether the
colon ":" or "O" must match the already existing character.
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FTP Managed Remote Request Tab

Configures the operation of remote file requests

Note that Grayed Items Are Not Available

NC Program Qualifier String

The Qualifier String is a required program identifier on the first line of the remote request program that signals
Focal*Point that the incoming program is a program request.

Request Code

The Request Code--usually the ASCII character "P" but may be any acceptable character--precedes the DNC*ID
number. This acts as pointer to a specific program as referenced in the DNC*Library. Note that both the Request
Code and Qualifier String can be changed for each machine in accordance with the machine's ability to output the
default control codes

Enable Remote Printing

This feature specifies the printer used for printing associated Part and Operation resource files when a remote file
request is received. Note that only files that have been tagged for Remote Printing will be routed to the specified
printer. For more information about tagging resource files see Parts and Operation resource attachments.

Sample Remote Request

The following sample program assumes that the user is requesting DNCID "35" as listed in the DNC*Library.

Program Output From The Machine Control

:1111 - Qualifier String
T35 - Program Request (Request Code "T" followed by the DNC*ID "35" )
M02 - Program Stop (Not Actually Required)
%

In the above example, Focal*Point will first verify the program as a file request by confirming the presence of the
Qualifier String. Next it will extract the DNC*ID number 35 to locate the program within the DNC Library and
place the program in the Managed folder.
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FTP Managed REC Confirmation

RECeive Confirmation is a feature that, if enabled, will provide the machine operator with a confirmation message
when programs are uploaded via FTP to the DNC system. The confirmation message will contain the first and last 5
lines—excluding the percent sign--of the received program plus a line indicating the number of bytes received.
These lines will appear as comments between the Header and Footer sections, which should be coded to conform to
the machine’s standard program structure.

Upon receipt of an uploaded program, Focal Point will place the formatted confirmation message in Managed FTP
folder

A typical confirmation message will have the following form.

% --- Beginning of header
O2222 --- Fixed program number
(RECEIVED PROGRAM FROM MACHINE) --- End of header section
(First extracted program line) --- Start of extracted program lines

.
(Fifth extracted program line) --- End of first five extracted program lines
--- Blank formatting line
(TOTAL BYTES BYTES RECEIVED NNNN) --- Information tag
--- Blank formatting line
(Beginning of last five extracted lines) --- These lines are taken from the end of the received program

.
(Last line of the received program) --- This will be the last program line excluding the % character
M30 --- Start of footer section
% --- End of footer

It is important to note that it is the duty of the operator to download the confirmation message. If the option to
delete requested files is activated, then the confirmation file will also be deleted.
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Restricted FTP

FTP Restricted Mode

The Restricted mode option allows the specified Machine/User to "Browse" anywhere within the base "Root" folder
and sub-folders but restricts GET and PUT functions to the defined folder or sub-folders, if selected. There are no
navigation restrictions applied. This is necessary to allow users to move out of the default GET folder and into the
PUT folder. This mode of operation does not act upon Remote File Requests. It simply designates a default GET
(download) folder which should contain only files for the specific machine.

The PUT folder is where the operator will PUT (upload) files that must be saved. If the "Move Received File to
Receive File Administrator" option is checked, all incoming programs will be moved to the Received File
Administrator when uploaded. Also, if checked, the program End-of-Blocks characters will be converted to the
standard Carriage Return and Line Feed (CR/LF) combination when the program is received. (Do not Use this
option when receiving binary or executable files.)

Aside from the User Name and Password required for FTP validation, no other options are available for this mode of
operation.
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Unrestricted FTP

Unrestricted FTP Mode

The FTP Unrestricted mode allows a Machine/User to "Browse" anywhere within the base "Root" folder and sub-
folders with "FULL" GET and PUT privileges. If checked, the program End-of-Blocks characters will be converted
to the standard Carriage Return and Line Feed (CR/LF) combination when the program is received. (Do not Use this
option when receiving binary or executable files.) This mode provides the most freedom to operators and does not
manage programs in any way.
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Advanced FTP Options

The Advanced FTP Options are best described by first discussing the operation of standard RS-232 remote program
requests.

Typical RS-232 Request Program: (See the Managed Folder, Remote Request section for details)
%
O1111
P2345 (P is the request code for DNCID 2345)
M30
%

When an operator performs an RS-232 request, Focal*Point performs a lookup based on the DNCID code as listed
in the DNC Library. In this case P2345 (above) is the DNCID being searched. When the program is located the
DNCID code may refer to a program with a completely different Windows' file name. For example, DNCID 2345
may refer to a program named mil5_part56_op2rev3.nc. At this point also consider that the internal program number
may be listed as just O2345.

Focal*Point then creates a "temporary" file and queues it for transfer to the machine control. The operator will never
see the Windows' program name, and in most cases the machine will record the internal program as number O2345.

Now consider FTP operation. If the same request program is received using the Managed FTP or Timer Folders
option, the Windows file, mil5_part56_op2rev3.nc, will be placed in the transfer folder. This situation can cause
potential confusion to an operator that has never before seen the actual Windows' file name. Therefore in order to
deal will this situation the Advanced Options do the following:

Requested File Conversion Options
Modify Windows File Name - if checked, it will cause the temporary file (a copy of the original) to be named
according the DNCID code. In other words, the file will be named 2345 rather than mil5_part56_op2rev3.nc.

Truncate Windows File Name to X characters - if specified, this will truncate the file name to X amount of
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characters. For example, if the DNCID is 2345.nc, the Windows file name truncated to 4 characters will be 2345.

Truncate at first Non-Numeric character - if checked, will cause a DNCID of 2345op3 to be named 2345.

Modify Internal Program Name Options
This function renames the temporary program's internal name. For example, if a program file does not have an
internal program number, Focal*Point will add the DNCID preceded by the Internal Name Identifier as the internal
program number. This allows the control to register the same program number as reflected by the requested DNCID
number .

The remaining options work exactly the same as the file conversion options discussed above.

Note that If Focal*Point displays "Internal_Program_Name_Not_Valid.txt", it simple means that Focal Point could
not modify the internal program number per the above rules.
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Timer Folders

Timer Folders

Functional Description

Timer Folders work almost identically to FTP Managed Folders and simply check for the existence of files in the
designated timer folder. The difference is that Timer Folders do not use or require Focal*Point's internal FTP server,
although they may be used in combination with third-party FTP servers such as the Mori FTP Server. As an
example, a client machine used with a Mori Server can place a Remote File Request program into the Mori Server
folder. The same folder is designated as a Focal*Point Timer Folder. As such, Focal*Point would then open the
program and recognize it as either a file request and act accordingly, or as an uploaded program and move it to the
Received File Administrator. If the program is a file request Focal*Point will place the requested file in the Timer
Folder (Mori FTP folder) which will then be accessible for download by via the Mori FTP client machine.

Note that a remote program request will fail if the requested program is not listed in the DNC Program Library or if
it is not listed according to the machine's Program Category within the Library. In such case a file is created named
"FILE ASSOCIATED WITH DNCID NOT FOUND" or "DNCID NOT FOUND".

A more common usage of Timer Folders is for controls utilizing network shares or mapped drive folders. For
security reasons a machine may be limited to browsing only a specific network folder/drive. If the folder is
designated as the Timer Folder then Focal*Point will provide a managed approach, as discussed above, for all
program transfers. In the case of network shares it will be necessary for your IT department to ensure that user
Rights and Privileges are restricted to a the designated folder--including appropriate measures for virus and malware
protection.

When checked, "Apply automatic EOB conversion" will change received End-of Block characters from line-feed
only to the standard carriage-return and line-feed. The "Purge Remote Request Files" will delete files in the Timer
Folder after the specified time period. Also note that only one file is allowed in the Timer Folder. For example, if a
Rec File Confirmation program is placed in the Timer Folder and a remote program request is immediately copied to
the same folder, the Rec Confirmation file will be deleted when processing the remote program request.
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Timer Remote File Requests

Configures the operation of remote file requests

Note that Grayed Items Are Not Available

NC Program Qualifier String

The Qualifier String is a required program identifier on the first line of the remote request program that signals
Focal*Point that the incoming program is a program request.

Request Code

The Request Code--usually the ASCII character "P" but may be any acceptable character--precedes the DNC*ID
number. This acts as pointer to a specific program as referenced in the DNC*Library. Note that both the Request
Code and Qualifier String can be changed for each machine in accordance with the machine's ability to output the
default control codes

Redirect Code

If necessary, and as a matter of convenience, a Rediirect code combined with a Focal*Point connection number
will queue the requested program for any RS232 connected machine. In many cases this may be a Mazak machine
using CMT program transfers. Considering that any shop PC may have the ability to access the shared Timer
Folders, remote program requests can be performed for any control that does not have the ability to output a
request file on its own. The only restrictions are that the code must be on the line following the program request,
and the requested DNC Library program must be listed within the machine’s designated Program Category. See
the example below for more information.
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Enable Remote Printing

This feature specifies the printer used for printing associated Part and Operation resource files when a remote file
request is received. Note that only files that have been tagged for Remote Printing will be routed to the specified
printer. For more information about tagging resource files see Parts and Operation resource attachments.

Sample Remote Request

The following sample program assumes that the user is requesting DNCID "35" as listed in the DNC*Library.
Program Output From The Machine Control

O1111 - Qualifier String
P35 - Program Request (Request Code "P" followed by the DNC*ID "35" )
R13 - Optional Redirection Code to Focal*Point Connection 13 (Must be a Library program listed for the target
RS232 machine)
M02 - Program Stop (Not Actually Required)
%

In the above example, Focal*Point will first verify the program as a file request by confirming the presence of the
Qualifier String. Next it will extract the DNC*ID number 35 to locate the program within the DNC Library and then
prepare the program for transfer on the redirected serial port #13. The NC file transfer will commence when
Focal*Point receives either a load command from the control, or it may begin automatically by using the Send
Standby Timeout feature as defined in the System Defaults and the machine’s communications options.
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Timer Folder REC Confirmation

RECeive Confirmation is a feature that, if enabled, will provide the machine operator with a confirmation message
when programs are uploaded to the DNC system. The confirmation message will contain the first and last 5 lines—
excluding the percent sign--of the received program plus a line indicating the number of bytes received. These lines
will appear as comments between the Header and Footer sections, which should be coded to conform to the
machine’s standard program structure.

Upon receipt of an uploaded program, Focal Point will place the formatted confirmation message in the Timer
Folder. A typical confirmation message will have the following form.

% --- Beginning of header
O2222 --- Fixed program number
(RECEIVED PROGRAM FROM MACHINE) --- End of header section
(First extracted program line) --- Start of extracted program lines

.
(Fifth extracted program line) --- End of first five extracted program lines
--- Blank formatting line
(TOTAL BYTES BYTES RECEIVED NNNN) --- Information tag
--- Blank formatting line
(Beginning of last five extracted lines) --- These lines are taken from the end of the received program

.
(Last line of the received program) --- This will be the last program line excluding the % character
M30 --- Start of footer section
% --- End of footer

It is important to note that it is the duty of the operator to download the confirmation message. If the option to
delete requested files is activated, then the confirmation file will also be deleted.
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Data Collection

Data Collection Configuration Menu

The Data Collection tab located within the Communications Parameters section contains several areas that define
how Focal*Point will extract and save incoming machine data. In general, the output data will represent probe
information stored in Macro variables and output with DPRNT statements.

Data Collection is an optional feature that must be purchased separately. A 10-Day trial is available by activating
the option in Focal*Point's help "Mange License" section. After activating the 10-Day trial you will have the option
to activate Data Collection on any single machine connection. During the trial period if you wish to test a different
machine connection, first uncheck the "Extract Data From Incoming Stream" check-box and then activate the option
on the new machine connection.

Data Collection Processing Notes

If the Extract Data From Incoming Stream option is selected then the incoming data stream is saved temporarily to
“ApplicationPath”/Temp Data Collection. The application path is where Focal*Point was launched from and is
typically “C\CNCINNOV\FPDNC”.

The temporary file takes the name: DataX, where “X” is the Connection/Machine Number for the CNC Control in
the Communications Parameters page. (Note: do not confuse this value with the assigned physical Comm Port
number.) The incoming data stream is stored in the temporary file until the user-defined value "Receive Delay"
seconds have elapsed since the last character was received. (The “Receive Delay” is set in Settings / Defaults / Misc.
The default value is 3 seconds.) At that point the Data Detection and Processing Routine is called. The “Data
Detection and Processing Routine” looks at the first 200 characters of the temporary file and applies the following
logic based on whether Continuous Data or Segmented Data has been selected.
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Continuous Data

If the option "All data will be sent from the machine in a continuous stream" option is selected:

1. If the Data Start Identification String is NOT found in the first 200 characters:
1.1. The file is renamed as a normal Focal*Point receive file and moved to the normal Receive
File Administration processing.

2. Otherwise
2.1. The File Naming Options are applied.
2.2. If the file naming is successful the temporary data file is renamed and moved to the Save To
Folder” specified for that specific machine.
2.3. If the file naming is unsuccessful then Data File Name Error Processing is applied. See the
separate description below for details.

Example
DATASTART
FILENAME D307-213.TXT
PRINT-TRUE
-------------------------------------------
1. ITM 62. CHAR 677. SHEET 3 SEC AF-AF
DIAMETER OF BORE 7.203 TO 7.205 TYP
VARIABLE NUMBER 860 7.2038
-------------------------------------------
FILEEND

- Indicates the start of a data segment
- The saved file will be named D307-213.TXT
- The File will be printed upon completion
- Saved Data
- Saved Data
- Saved Data
- Saved Data
- Saved Data
- End of Data Collection

Segmented Data

IMPORTANT: A data segment is any continuous data stream that does not pause for more than the “Receive Delay”
seconds. ( Specified in Focal*Point Settings / Defaults / Misc. ) If the option "Data will arrive in segments" is
selected, segmented data processing is applied and you have the option to append a Date -Time stamp to each
received segment.

The DATE-TIME stamp is appended when we receive any DPRNT statements following the DATASTART. The
format is YEAR:MONTH:DAY - HOUR:MINUTE:SECOND. If you want to determine elapsed time of a machine
cycle, enable the DATE - TIME stamp and send DPRNT statements after the DATASTART and before the
DATAEND. For example, CYCLE-START or CYCLE-END. The elapsed time is the difference between two
DATE-TIME stamps.

For Example:
DATASTART
CYCLE-START DATE-TIME 2010:01:05-14:07:22
CYCLE-END DATE-TIME 2010:01:05-14:09:31
DATAEND DATE-TIME 2010:01:05-14:09:35

In this example the cycle started at 14:07:22 and ended at 14:19:31 for an elapsed time of 12 minutes and 9 seconds.

Segmented processing is considerably more complicated than the Continuous Data processing. Please read and
understand the following before using the Segmented Data option.

Segmented processing is expecting a series of data segments with the first segment containing a Data Start
Identification String and the final segment containing the Data Termination Identifier String. There are multiple
reasons this may not occur. One example: An operator may need to terminate an operation before normal
completion of a cycle because of a broken tool. He may then start the cycle over from the beginning. In this case
Focal*Point would receive a new Data Start Identification String without receiving a normal Data Termination
Identifier String. Thus, a set of rules are built into the Segmented Data processing to deal with potential exceptions.
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Segmented Data processing is carried out in the following order:

1. If a data segment exceeds the defined Maximum Segment Length it is assumed to be an incoming file for
saving and not a data segment. (Example: An operator terminates a program mid-cycle because of a
problem and then sends the program he was working on back to Focal*Point to have engineering look at it.)

1.1. If no prior data has been received the file is treated as a normal receive file and moved to the
normal Receive File Administration processing.
1.2. If prior data has been received but not properly terminated, that existing data file is appended
with “ABNORMAL TERMINATION: SUBSEQUENT SEGMENT EXCEEDED MAXIMUM
SIZE”

1.2.1. The incomplete data file is then moved to an error folder within the specified Save To
Folder. If the error folder does not exist it is automatically created.
1.2.2. The incoming segment in excess of the Maximum Segment Length is renamed as a normal
Focal*Point receive file and then moved to the normal Receive File Administration processing.

2. If a data segment contains a Data Termination Identification String within the first 200 characters then:
2.1. If no prior data has been received.
2.1.1. If a Data Start Identification String is found in the same segment the incoming segment is
then processed identically to Continuous Data stream as above.
2.1.2. If no Data Start Identification String is found in the same segment the segment is appended
with “ABNORMAL TERMINATION: TERMINATION FOUND BUT NO PRIOR START” and
the segment is then moved to an error folder within the specified “Save To Folder”. If the error
folder does not exist it is automatically created.
2.1.3. This is normal processing. If prior data has been received and not yet terminated the
segment is appended to the data file and the file is processed identically to Continuous Data
stream as above.

3. If the data segment contains a Data Start Identification String within the first 200 characters then:
3.1. If no prior data has been received, a new temporary data file is created and Focal*Point waits
for additional segments.
3.2. If data has already been received but not properly terminated, that existing data file is
appended with “ABNORMAL TERMINATION: NEW DATA START BEFORE END”
3.2.1. The incomplete data file is then moved to an error folder within the specified “Save To
Folder”. If the error folder does not exist it is automatically created.
3.2.2. A new temporary data file is started with the contents of the recent segment.

4. If the data segment contains a Remote Request Qualifier String within the first 200 characters then:
4.1. If no prior data has been received the segment is moved to the normal Receive File
Administration processing.
4.2. If data has already been received but not processed that existing data file is appended with
“ABNORMAL TERMINATION: REMOTE REQUEST RECEIVED”
4.2.1. The data file is then moved to an error folder within the specified “Save To Folder”. If the
error folder does not exist it is created.
4.2.2. The incoming segment with the Remote Request is then moved to the normal Receive File
Administration processing.

Additional Options for Data Collection

Although the remaining options are self-explanatory, it is worth mentioning that Focal*Point allows you to specify
the location for your saved data files and the naming conventions for the files. The ability to extract a file name and
append the date and time to the name is helpful for isolating and sorting collection data based on the program and
run date.

In some cases it may be desirable to print the captured data for immediate review--to that end two options are
available, "Always Print" and a "Print On Command." The Print on Command, if active, will print the entire file
upon completion of the capture sequence.
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Program Maintenance

Focal*Point stores all of its setup and operating information within its two operating database files. Therefore, it is
important to purge and compress these files whenever possible. This action is necessary not only to maintain the
size of the files, but it also allows Focal*Point to run more efficiently.

Purge Send File History
(View Menu)

To view the transfer activity, simply click the Send File History selection located in the Database menu. After
reviewing the history, it is highly recommended to purge (delete) the records by clicking the Purge button located
within the viewer window. By purging records on a periodic basis, you will easily control the size of the
fpshare.mdb database. To save a hard copy of the history, simply click the print icon along the top menu bar and
select "Disk File" as the output device.

Archive File History
(View Menu)

The File Archive feature, when enabled in the Defaults menu, will save and archive DNC*Library files that are
targeted to be overwritten from within the Receive File Administrator. Archive transactions are recorded at each
Focal*Point workstation, and are maintained within the Fplocal.mdb database. To view and purge these records,
simply open the Archive History window located in Focal*Point’s Database menu.

DB Optimizer

The DB Optimizer is a separate utility included with Focal*Point. It is accessed from the Windows Start menu
within the Focal Point program group. The DB Optimizer will repair and compress Focal*Point’s database files. Use
the repair function anytime you suspect that the database has been damaged or corrupted. The compress function,
which should be performed after purging the "Send File" and "Archive" history, will further reduce the size of the
database files and should be performed on a periodic basis.
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Database Optimizer and Repair Utility

Included with Focal*Point is a separate utility for maintaining Focal*Point's database structures. The utility
specifically maintains the Fplocal.mdb file that resides in Focal*Point's INIT directory and the Fpshare.mdb, which
is found in either the INIT directory or the designated common LAN directory. For best results, it is advisable to
purge the Send File History from the FpShare.mdb before running the Database optimizer. To purge the history,
simply select Send File History from Focal*Point's main Database menu and follow the procedures for purging the
current data.

The Database Optimizer should be run on a regular basis, as it will minimize the size of database. This is especially
true when frequent additions and deletions are performed to the DNC*Library. Furthermore, since the utility must
have complete access to the database structures, it will only run when Focal*Point is not in use. It is best to create
the scheduled task to run during the evening when all users are logged out of Focal*Point. Also be sure to create a
separate task for both the repair and compact functions

Important: Do not attempt to run both tasks at the same time--create separate start events while providing ample
time to complete each function. It is also best to run the check and repair function before the compact function.
When run as a scheduled task the DBOptimizer will suppress the usual message boxes and record the event in the
DBOptimizer log file.

To check and repair the database run the command line <drive>:\cncinnov\fpdnc\FPUtils.exe <space> Repair.
Where <drive> represents your harddrive and <space> represent the space character. For example:
c:\cncinnov\fpdnc\FPUtils.exe Repair

To compact the database run the command line <drive>:\cncinnov\fpdnc\FPUtils.exe <space> Compact. Where
<drive> represents your harddrive and <space> represent the space character. For example:
c:\cncinnov\fpdnc\FPUtils.exe Compact
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Automating Program Restart

Automated restarts are useful when wireless or single-port RS232 devices are directly attached and powered by a
machine control. In such cases an evening shut-down of the machine will break Focal*Point's COMM link with the
device and require a manual port activation to re-establish the COMM link when the machine returns to operation.
Fortunately Focal*Point has a built in discovery function to activate "Not Loaded" devices. It should be noted that
this function does not reactivate a device listed as Rec Stby which has been previously powered down. For this
reason it may be more efficient to automate a program restart prior to machine power-up in the morning.

The easiest way to accomplish the restart is by using the Task Scheduler or via controls offered by service
management software such as FireDaemon Pro. When using either method it is always best to disable Focal*Point's
exit warning pop-up message as seen when exiting the program. Doing so will assist in a graceful shut-down of the
software by allowing it to close open database connections. See the Defaults Miscellaneous tab for more
information.

See below for instructions using FireDaemon Pro when running Focal*Point as a service.

How To Use The Task Scheduler

The best method is to first create a Shutdown and Startup VBscript file and save them as follows:

StopFocalPointProcess.vbs

Dim oShell : Set oShell = CreateObject("WScript.Shell")
oShell.Run "taskkill /im FocalPT.exe", , False
WScript.sleep 2000

'Remove Comment (') for next two lines if using this script on Focal*Point versions prior to 5.2
'oShell.AppActivate ("Focal Point")
'oShell.Sendkeys "y"

WScript.Sleep 10000
WSCript.Quit

StartFocalPointProcess.vbs

Option Explicit
Dim objWMIService, objProcess, WshShell
Dim strShell, objProgram, strComputer, strExe

set WshShell = WScript.CreateObject("WScript.Shell")
'Enter the execution path for your installation of Focal Point

strExe = "c:\cncinnov\fpdnc\focalpt.exe"
strComputer = "."

' Connect to WMI
set objWMIService = getobject("winmgmts://" & strComputer & "/root/cimv2")

' Obtain the Win32_Process class of object.
Set objProcess = objWMIService.Get("Win32_Process")
Set objProgram = objProcess.Methods_("Create").InParameters.SpawnInstance_
objProgram.CommandLine = strExe

'Now Execute the program at the command line.
Set strShell = objWMIService.ExecMethod("Win32_Process", "Create", objProgram)
WSCript.Quit

These two files should be placed a folder for access by the Task Scheduler

Now we are ready to create a scheduled task. (Screens are Windows 7 )
Navigate to the Start menu and open the Accessories > System Tools menu and click Task Scheduler.
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Now create a new scheduled task as follows.

Specify the trigger time to start the task(s).
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Add two actions to run the two scripts created earlier. Be sure run the StopFocalPointProcess first.

Finally, and for convenience, allow the task to Run on Demand and Do Not start a new instance as the Start script
will handle the restart.
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Option Two

Running Focal*Point as a Service With FireDaemon Pro software.

Starting with Windows Vista it is far, far easier to run Focal*Point as a service using specialized service
management software such FireDaemon Pro. Doing so will simplify setup and provide numerous options for
starting, stopping and running Focal*Point. First and foremost, running as service allows Focal*Point to run even
before a user as logged in. This is convenient should your PC need a restart due to Microsoft updates and such.
Another issue that is easily solved with FireDaemon Pro is that it provides a simple 1-click method to view Session
0 where Focal*point will be running.

Since the introduction of Windows Vista and above, Microsoft no longer runs services in the user space of a logged
in user. This process is referred Session 0 Isolation (see Microsoft for details). This means that even though the
program is running there will be no GUI user interface to manipulate Focal*Point or any of its modules such as the
DNC Library or Receive File Administration. In order to view and manipulate Focal*Point it is necessary to view
Session 0, which is a desktop view that is not immediately available to users.

Microsoft provides a tool to using Interactive Services Detection using a command line utility to display a pop-up
providing access to the Session 0 desktop. to avoid such manipulation, and as stated earlier, FireDaemon Pro
provides quick access to Session 0 with the simple click of a button.

The following images show the preferred setup for running Focal*Point as a service with FireDaemon Pro.

From the main menu create a new service and name it accordingly. Startup Mode should be Automatic.
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In Settings, click to Interact with Desktop and provide a user Login Account and Password
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Be sure to click Graceful Shutdown in the Lifecycle tab.

Shown below is the Pre / Post Service screen. The important Executable is a command file created to ensure that
mapped drives will be available to Focal*Point. This is especially important when NC files or the shared database
library is located on a shared network drive.

A command program has been created and named connectdrives.cmd that contains the following Net Use
commands.

net use q: "\\diskstation\ncfiles q" CncM# /user:ITadminMgr /persistent:YES
net use Y: "\\diskstation\fpshare" CncM# /user:ITadminMgr /persistent:YES

Naturally you will need to change the specifics for your file but the general format for the command should be.

net use <drive letter:> \\Companyshare\DNC [user Password] /user:<username> /Persistent:YES
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Pre / Post Service Settings

Click the Insert button and navigate to your connectdrives.cmd file.
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Finally, set a schedule for Focal*Point and include a restart time. Be sure to include a restart delay to account for the
shutdown of the running instance.

This completes the setup for running Focal*Point as a service using FireDaemon Pro. To view and manage
Focal*Point simply click the Session 0 button from the main screen of Fire Daemon Pro.

If you would like even more desktop interaction in the Session 0 screen, see the article for running the Taskbar in
Session 0 at the following website. http://forums.firedaemon.com/howtos/taskbar-in-session-0.142/
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Communications Troubleshooting Guidelines

NOTE: We will be happy to answer questions about configuring and using Focal*Point, but we can not offer free
assistance in configuring the machine control or in using communications on the control. Extended technical
support may be purchased for these issues on a pre-paid hourly basis.

For extended troubleshooting it is advisable to run Focal*Point from a laptop computer situated next to the machine
control as this will save the time spent walking to and from a remote Focal*Point host! Before doing so, be sure to
configure the Communications Parameters to use the laptop's serial port.

Always start troubleshooting by sending from the machine control to Focal*Point. The Focal*Point software is
much more flexible in how it receives data and will not issue an "alarm" like machine controls do. Also, the nature
of the data received may help you identify the source of the problem.

Follow these steps if you are having a problem communicating with the machine control.

1. Send a program from the machine control to the PC.

UIf the machine "alarms":U

The cable may not be connected to the correct port at the machine control.
Check the cable configuration at the machine end, particularly pins 6, 8, and 20.

UIf the machine acts like it is prepared to send but "sits" continuously in send mode:

A file will not be sent if the CTS line (line 4 or 5 depending on the machine
configuration) is not asserted. The cable should have a jumper between pins 4
& 5, or lines 4 and 5 should pass through to their compliment lines on the
computer end.

UIf the machine looks like it is trying to send but you receive nothing in the Receive File
Administrator:

Check the cable. Pins 2 and 3 may need to be swapped to match the
send/receive lines on the machine control with the receive/send lines on the
computer. If hardware handshaking is being used and pins 2 and 3 need to be
swapped pins 4 and 5 will also need to be swapped.

Check to see that the correct port has been selected. A quick test is to unplug
the cable while trying to send. If an alarm is shown, then the correct port is
being addressed.

Check the Focal*Point communications parameters to be sure the correct COM
port has been selected.

Try sending to Focal*Point from another machine control or another computer
to verify the COM port is not defective.

UIf "garbage" prints out on the computer screen while receiving:

The communications parameters are probably mismatched. Check to see that
the data types (ISO, EIA, or ASCII) match. Many machines have a parameter
setting to select between EIA and ISO. Then check the baud rate.

Other possible sources of "garbage" are long cables, cables with weak
connections, cables running near EMF sources, or ground faults.
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2. Once data has been successfully received, most cable, machine parameters, and COM port
configuration problems will be eliminated.

Now send from Focal*Point to the machine control.

UIf Focal*Point appears to send the file but the machine acts like it is not receiving:

Check the file contents. Perform the initial tests with a file which has been
received from the control, not one generated on your CAD/CAM system. Some
controls require an end of block at the beginning of the file or require a program
qualifier (like O2213) at the beginning of the file. Others require a M30, M02,
%, or END at the end of the file.

UIf a partial program is received (blocks of data appear to be dropped), or the machine issues a data
overflow alarm:

Make certain that the computer's RS-232 ports are not configured to utilize their
built-in FIFO buffers. This setting is accessed from the Windows Control Panel
and is discussed in the Program Setup section.

Check to make sure handshaking has been properly enabled. If the cable uses only lines 2, 3 and 7
select X-ON/X-OFF protocol. (Also referred to as Software Handshaking or DC1/DC3 control
codes.) If the machine does not support software handshaking use a cable with pins 4 and 5
connected. This will enable CTS/RTS handshaking.
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Cable and Wiring

RS-232 serial data transfer remains the single most popular means for communicating with modern CNC equipment.
Although capable of high transfer rates, interference from Ground Loops, Radio Frequency (RFI), and Electro
Magnetic Interference (EMI) can greatly impede the reliability and performance of any DNC system.

To minimize the possibility of data corruption, and worse yet, physical damage, review the following guidelines
when considering the installation of cable for your DNC system.

Ground Loops

Simply stated, a ground loop occurs when two devices Udo notU share the same source of ground. And, since the
ground signal sets a common frame of reference for data signals, a ground loop can inhibit all communication
between the devices. Furthermore, if the potential difference between the two devices exceeds 30 volts, circuit
damage is likely to occur.

By far, the best way to avoid ground loops is to make certain that all equipment, machines and computers alike, share
the same ground source, and the best source is earth ground through the use of grounding rods. As for computer
equipment and external port hardware, never eliminate or by-pass the third wire ground lug on the AC line cord.

Interference

Interference with RS232 data can be introduced in many ways. Fortunately, careful selection, routing, and placement
of the transmission cable can eliminate the most common factors.

The following list outlines the major considerations for avoiding data corruption from interference:

· Make certain that all equipment is properly grounded.

· Computers and external hardware should be equipped with surge protection devices.

· Individual RS232 lines should be fitted with inexpensive surge filters.

· Select good quality cable that utilizes both a foil and braided shield.

· Follow the appropriate procedures for wiring diagrams, paying special attention to solder, shield, hood, and
screw connections.

· Avoid excessively long cable runs.

· Avoid routing cable in the vicinity of EMI generating equipment, such as: wire EDMs, arc welders, plasma
cutters, large motors, fluorescent lights, etc.

· Although rare, another potential source of sporadic problems is radio transmitters. This is especially true in the
vicinity of Amateur or CB transceivers when cable lengths approach multiples of a quarter wavelength of the
operating frequency.

Installation Considerations

· Always label each end of the cables to provide easy identification.

· Cable ends should be routed to provide free and easy access for connector assembly.

· Take special care when routing in the vicinity of overhead cranes or other movable equipment.

· External port hardware, such as Digiboard Concentrators, should have a secure mounting platform (typically
18" x 12") and easy access to an AC power source.

· Keep in mind that 32 port concentrator systems require that the first 16 ports be filled before connecting to the
second concentrator.
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Resolving Problems

· Independently verify that a CNC will indeed communicate via its RS232 port before assuming the DNC system
is defective.

· When confronted with extremely long cable requirements, consider the use of RS422 adapters or short haul
modems.

· Extremely problematic environments--especially those with ground loop difficulties arising from building to
building communication--will benefit from optical-isolators. These devices serve to protect equipment from
surges as high as 2500 volts while maintaining data integrity.

· In areas of high intensity electrical fields, consider enclosing the cable within well-grounded electrical conduit.
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Wiring Diagrams

We highly recommend the use of surge suppressers to reduce the potential for lightening and other surge damage to
the machine controls. These may be obtained from CNC Innovations, LLC.

It is your responsibility to verify serial cable requirements for the control. If in doubt, refer to a machine control
dealer or a qualified service representative.

As cabling and machine configuration requirements go beyond the specific range of our product, we can not offer
free technical support for either of these configuration problems. Extended technical support may be purchased for
these issues on a pre-paid hourly basis.

Following are suggested cable configurations. Two configurations are for Machine to Port Hardware, one is for
RTE-1000 installations, and one describes the RS422 wiring for the computer to a Digiboard Concentrator.

If these configurations do not work refer to your machine control manual for more details.

Suggested Cable Configuration for Software Handshaking

(Software may be referred to as Xon/Xoff or DC1/DC3)

Suggested Cable Configuration for Hardware Handshaking
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Frequently Asked Questions

Communication Problems

Q. After a Remote Request or Send operation the main display window continues to indicate "Sending" in the
file Status bar.

A. This situation occurs when NC files contain extra end-of-block characters at the end of the program and
your control responds to an M30 or percent sign prior to the EOB characters and your control immediately
responds by terminating the program load. Although the situation is harmless, you can remedy the problem
when you create your NC programs by eliminating the extra EOB characters. Alternately, use Focal*Point's
strip character--in this case % is decimal 37--to strip the code during file transmission and simply add the
% as a Start and End character. This will ensure that there are no stray characters at the end of your
program files. Another method is to enable the COM option parameter “Purge if Sending and Inactive.”

Q. On our dual concentrator system (greater that 16 ports), one of the units displays "P1" and we cannot
establish communications.

A. In some situations electrical noise can disrupt the internal settings of the concentrator units. As such, we
always recommend the installation of a U.P.S. system. However, to establish communications it will be
necessary to power-down both of the concentrators and then apply power to the first unit before turning on
the second unit. In normal operation both units should display "AC".

Q. I can not read the packet information for my Mazak files.

A. Be sure to save Mazak files with an MZP extension. The extension tells Focal*Point how to display Mazak files.

Q. While loading a program in my control, I only receive part of the program and Focal*Point appears to
hang-up.

A. In the communication parameters for Focal*Point, try enabling the "Ignore Incoming Data While Sending"
option. Since Focal*Point is capable of re-queuing a file (via remote request) that is currently being
transferred, if a control echoes received data it may cause Focal*Point to process the data as an invalid
remote request. As such, your control may timeout and terminate the load sequence.

Q. Bridgeport series 3 & 4 controls do not load properly; they appear to lose data.

A. Bridgeport controls may require end-of-line Null characters. This parameter is located in the
communications section.

Remote Request Problems

Q. I issue a remote request but the software does not respond.

A. It may be necessary to enable the XOFF delay found in the Defaults menu. The delay is supplied in order to
provide support for different hardware and software configurations. Make certain that the format of the
remote request file exactly matches Focal*Point’s setup. This especially true for the Program Qualifier and
Request Code strings.

Q. Focal*Point will not recognize a remote request from an RTE-1000.

A. Make certain that the NC Program Qualifier String--located in the Communication Parameters--is empty;
and that the Request Code is "T".

Furthermore, after inputting a numeric only DNC*ID number and pressing the RTE’s "Enter" key you must
UwaitU a few seconds before pressing the "Start" key. Otherwise Focal*Point will queue the file but it will
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miss the X-on (Start) code. You can by-pass the wait period by utilizing the Send Standby Time-out
feature, which will automatically initiate the file transfer.

Q. Does Focal*Point support the Burr-Brown keypad?

A. For customers using the Burr-Brown keypad, simply select Burr-Brown from the Key Pad menu in the
Remote Request section of the Communication Parameters.

Q. Does Focal*Point support the QSI Terminal?

A. For customers using the QSI Terminal, simply select QSI from the Key Pad menu in the Remote Request
section of the Communication Parameters.

Q. How do I use Easytalk to issue a remote file request?

A. Easytalk Version 7.0 will issue a remote file request if Focal*Point is configured for a hardware handshake
and the Keypad Type is set for QSI Terminal.

General Considerations

Q. Can our NC programmers add files to the DNC*Library?

A. There are two methods to add files to the Library. First, they can load Focal*Point as a DNC Administrator,
or secondly, they can utilize the Automatic Library Transfer feature.

Q. I know that Focal*Point's RFA has received files from certain controls, but when I click on the Cell name
for those controls I don't see the received files.

A. In rare cases and when using older versions of Focal*Point, the connect.mdb database file may be
damaged. Either replace the file (located in the shared file directory as specified in Multi-User
Administration) with a backup copy or perform the following procedures to re-index the database file.

1. Save any data files located in the Multi-User Administration directory.

2. At each seat of Focal*Point, disable (un-click) LAN Connectivity in the Multi-User
Administration window. Follow the on screen instructions and shut down each seat of
Focal*Point; do not restart Focal*Point at this time.

3. Access the Focal*Point shared file directory--this is usually x:\fpshare (where x is your network
drive). In this directory delete the file Connect.mdb.

4. Starting with the DNC host PC, re-start each seat of Focal*Point and re-connect LAN
Connectivity by specifying the shared file directory and Cell name.
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Legacy Security Keys

Focal*Point version 4.9 and greater no longer uses or supports legacy security keys and dongles. All licensing is
provided through password keys on each workstation. See the Manage License section accessed in Focal*Point’s
Help menu or as displayed during the startup splash screen.
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Backup Strategies

Focal*Point, like most communication software, is dependant on a number of interrelated components that in their
various functions enable Focal*Point to work as a stand-alone program or in unison with multi-port hardware
devices. Additionally, each configuration may or may not utilize the resources of an attached LAN network. It is
within this multitude of operational characteristics that this section will attempt to prepare the Focal*Point user to
re-establish communications when various problems occur.

General Backup Procedure

The first and most important safeguard is to make backup copies of Focal*Point's configuration files. Without these
files, Focal*Point will not function as intended. All of Focal*Point's defaults, communications, and LAN
connection parameters are stored in Microsoft Access V 7.0 compatible database files. During installation these
files are stored in the fpdnc\init directory and are recognizable by their MDB file extension. When Focal*Point is
configured to utilize LAN resources, additional files will be created and will reside in the shared Multi-User
Administration directory specified within Focal*Point's Settings menu.

The following list illustrates each file, its purpose, and its location.

Focal*Point without Multi-User Administration

File Name Description Location

FPLocal.mdb Stores Default parameters and \cncinnov\fpdnc\init
Com. Settings.

FPShare.mdb Stores NC Program Categories, \cncinnov\fpdnc\init
DNC Library, Parts and Send History

Focal*Point with Multi-User Administration

File Name Description Location

FPLocal.mdb Stores Default parameters, \cncinnov\fpdnc\init
Com Settings and LAN connection attributes

FPShare.mdb Stores NC Program Categories, Specified in Multi-User
DNC Library, Parts and Send History Administration

Connect.mdb Stores Cell, Workstation Specified in Multi-User
And Port Information Administration

Each of the above files should be included in your regular system backup. The most important of which is the
FPShare.mdb because it stores the DNC*Library information. The remaining files need only be saved when the
system configuration is changed.
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Configuring a Backup DNC Server

Note: With the release of Focal Point version 4.10 it now easier than ever to configure a backup laptop PC. If a
backup roaming laptop will satisfy your requirements, then we highly recommend that you look at the “Single-Port
plus Administration” license configuration.

If your requirements call for a backup file server then read on.

For quick recovery of a failed DNC file server it has become increasingly popular to configure an additional PC as a
backup Focal*Point host. To that end, it must be stated that a backup PC is easiest to maintain when Focal*Point has
been configured for Multi-User Administration, that is, a shared DNC Library database is located on a LAN drive
and NC program files are also stored on a network drive. If neither of these ideals is true, it becomes necessary to
constantly mirror Focal*Point’s database and the NC program files on the backup PC. For the purpose of this
discussion we will assume that all files are located on shared network drives. For more information about a shared
database read the section regarding Multi-User Administration in the Focal*Point help program.

Before getting started, one consideration is the use of a laptop PC as a backup server because it can also be used as a
portable program loader when there is a problem with existing RS-232 serial hubs. This article will first outline the
general requirements for configuring a backup server and conclude with a short discussion regarding laptop
configurations.

 Software Licensing

When duplicating a Focal Point server the first point of consideration is the software license. Is a second software
license required? Fortunately the answer is no. Focal*Point, when installed on a new PC, will work unlicensed for
10-days. For many people that time frame offers sufficient insurance against a failed DNC server. However, it does
not guarantee protection since the 10-day limit is easily exhausted.

Aside from purchasing a full license or gambling with a limited 10-day license, CNC also offers a complimentary
annual backup license to all customers enrolled in its Comprehensive Support Program. This license is issued upon
request from all enrolled participants and runs concurrent with the support agreement.

 Configuring the Backup PC

The following section outlines the procedures required for successfully configuring a backup PC.

Assuming that the main system utilizes Ethernet based RS232 LAN to serial hubs running on a Windows 2000 or
above operating system, the first step is to determine the current configuration for the hubs. This is done by viewing
the properties for each hub as displayed in the Windows Device Manager. Locate the section for Multi-port Serial
Adapters and record the order of the hubs, their IP and MAC address, and their subsequent COM port numbering
sequence. For example, if two 8-port hubs are used, the first hub will likely contain COM 5 though 12 and the
second hub will contain COM 13 through 20. Be sure to record both the hub MAC address and port sequence for
each hub in your network.

With this information you can proceed to install the hub drivers on the backup PC. However, when doing so, it is
best if both operating systems use the identical driver version--the original drivers are usually located on the main
PC in a folder named Comtrol. If the identical drivers are not available, you should download the latest drivers to
ensure compatibility. See HTUwww.comtrol.comUTH for more information and updated drivers.

After installing the drivers it is important to open the device properties located in the Windows Device Manager and
designate the MAC or IP address and COMM port sequence in order to match the original installation. After
successfully installing the first device repeat the above steps for all remaining devices.

Tip – When using MAC addressing it is best to disable all IP addressing as accounted for in the device
properties. Please refer to Comtrol’s driver documentation for more information.

http://www.comtrol.com/
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Next you will install Focal*Point on the backup PC and enter a license code or select day 1 of the 10-day trial. You
will also want to copy Focal*Point’s configuration files as describe in the following paragraph.

At the main Focal*Point computer, use Windows Explorer to navigate to Focal*Point’s database folder, usually
c:\cncinnov\fpdnc\init. Within this folder you will find two important files, FPLocal.mdb and FPShare.mdb. Copy
FPShare.mdb to the same folder in your backup PC. Important – In Multi-User, shared configurations, the
FPLocal.mdb file requires a small internal change so as not conflict with the existing server. This change is provided
free of charge for customers enrolled in our Support program. Please call 508-523-1763 for details.

Upon receipt, put the FPLocal.mdb in the same folder as your FPShare file. Next, make one final check that all drive
mappings and privileges have been duplicated on the backup PC. This will ensure proper access for Focal*Point’s
shared LAN folder and the NC program folder as listed in your DNC program library. Now start Focal*Point and
connect to the shared database using Multi-User Administration located in the Settings menu. Browse and select the
shared folder as previously set in the original PC and also enter a unique Cell name such as Backup PC.

At this point you must shutdown the main PC and restart the backup PC in order to gain control of the
communication hubs. Proper connection can be verified by viewing the Device Adviser tab located within the
Comtrol driver properties dialog for each hub. If all is well the Device Adviser will display the message “Device is
Active and OK.”

After restarting you should see the familiar main screen populated with your machine controls. The Status bar
should indicate [Rec Stby] for all active connections. If the status indicates [Not Loaded] you should verify that the
main PC is off and double check the installation of the RS232 hardware and COM port designations in the device
properties.

This completes the setup and allows you to resume normal communications with all your machine controls. When
you are satisfied that the backup PC works as intended, you should then disable the hub drivers to avoid conflicts
when, and if, both PCs are running simultaneously. Remember that only one PC can have control of the serial hubs.

The drivers are disabled by right-clicking on the hub(s) in the Device Manager and selecting the Disable option. In
the future, should it be necessary to activate the backup PC for communications, you will simply Activate the
drivers and start Focal*Point. Until then, the backup PC can be used as any other Administration seat.

This concludes the discussion for configuring a Backup DNC server. The next section will discuss options for using
a laptop as a portable program loader in the event that problems extend to the RS232 communication hubs.

 Laptop Options

If a problem should arise with the RS-232 communication hubs, even the backup PC will fail to initialize the COM
ports. In this situation you may still have wireless access to your NC program files, or if you have planned ahead,
you will have a CD or USB drive that contains copies of your programs.

To communicate with any machine simply change the COM port number to use the laptop’s COM 1 port. (This is a
temporary measure so be sure to reset the port to its original setting when you are finished.) To change the COM
port, highlight the target machine’s name on Focal*Point’s main menu and then open the Communication
Parameters located in the Settings menu. In the Required Parms tab, change the COM PORT number to COM 1 and
click the Reset and Save buttons.

At this point if you connect an RS-232 null-modem cable to the machine, you can perform normal program
transfers. If, however, you are using a CD image of your NC program files, it will be necessary to use the Send
Browse feature, located in the File Menu, to select and transfer programs to the machine.

In conclusion, configuring a backup PC is generally a simple exercise as outlined in this document. Keep in mind
however, aside from general questions, CNC Innovations cannot offer unlimited installation support for backup PCs
since installation services are generally provided as paid services.
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ASCII CHART
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TECHNICAL SUPPORT REQUEST FORM
Email to info@cncinnov.com

Contact Information Date ________________

Company _____________________________ Contact ____________________

Product _______________________________ Version ____________________

Tel: _____________________________ Fax: ____________________

Describe the Problem

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

Steps to Reproduce the Problem

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

Background Information

Control _____________________________ Model # ________________________________

Computer ____________________________ Operating System _________________________

Is this a new installation? ______________________

Has the problem occurred before? _________________

Previous contact at CNC ____________________________________________
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About CNC Innovations, LLC

CNC Innovations started in 1988 as a software division of CNC Engineering, Inc. At that time CNC Engineering
sold and supported several third-party manufacturing software solutions including DNC communications packages.
As CNC Engineering's software division gained experience with the available third-party products it became
apparent that customers were looking for more innovative and cost-effective solutions. As a result, in 1991 CNC
Engineering decided to spin-off CNC Innovations as separate software company dedicated to developing, marketing,
and supporting a totally independent line of manufacturing software.

CNC Innovations' early products focused on using emerging laptop PCs for DNC communications and file
management. The goal in using PCs was to provide flexible and cost effective solutions that were no longer
dependent on proprietary hardware. As a result, Easytalk, the first PC based DNC product developed. Easytalk was
well received by the marketplace and quickly became an industry standard, which set the stage for the development
of subsequent product ideas. Coupled with refreshing product innovation and unsurpassed customer support, CNC
Innovations quickly evolved to become one of the dominant players in the DNC marketplace.

After ten years as "sister companies" CNC Innovations, and CNC Engineering, Inc. again merged their operations.
Under the terms of agreement, the merger took effect January 1, 2000 with the combined company name being CNC
Engineering, Inc. As a result of the merger, the companies were able to combine their knowledge of CNC machine
controls, retrofits and manufacturing software, thereby enabling CNC Engineering to provide complete integration
of the entire line of products and services.

Moving forward, and after nearly six years under the umbrella of CNC Engineering, in 2006 CNC Innovations once
again realized that its customer's needs were best fulfilled by the concentrated efforts of a separate company. By
branching out, the re-established CNC Innovations was able to provide a much quicker and more dedicated response
to customers.

CNC Innovation, LLC is now based in Auburn, MA, and continues to support Focal*Point DNC and its legacy
products such as Easytalk, Easytalk MultiTask, Scripted Assembly and Inspection Processing, the GForce NC file
editors, In-Process Part Acceptance, and CNC Infrastructure Support Services, all of them, the best shop-floor
software available.

We sincerely hope that you will participate in our growth and enjoy our products.

CNC Innovations, LLC


